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Faxitron® Path

Sistema de radiografia de muestras

Prologo

Este manual ha sido creado por Hologic®, Inc. Tiene el objetivo de guiar al usuario durante la configuracion, la instalacion y el
uso del hardware Faxitron Path, asi como del sistema de software Vision, ambos desarrollados por Hologic® Inc.

Faxitron Path anteriormente recibia el nombre PathVision

El usuario debera configurar primero el hardware y, a continuacion, iniciar el software Vision. Antes de continuar, revise los
procedimientos de configuracion obligatorios incluidos en la segunda parte de este manual.

Indicaciones de uso

El sistema Faxitron Path es una cabina de rayos X que se utiliza para obtener imagenes de rayos X de pelicula o digitales de
especimenes procedentes de varias regiones anatdmicas con el fin de verificar rapidamente que durante la biopsia se haya
extirpado el tejido correcto. Realizar la verificacion directamente en la misma sala o en sus proximidades permite que los
casos se concluyan mas rapidamente, limitando asi el tiempo necesario para explorar al paciente. La radiografia de los
especimenes puede limitar potencialmente el nimero de citas para los pacientes.

¥'Uso con receta médica (parte 21 CFR 801, subparte D)

A Precaucion: De acuerdo con la legislacion federal, la venta de este instrumento queda restringida a los médicos o por
prescripcion de los mismos.

El sistema puede funcionar como un dispositivo autbnomo. Si se conecta a una red, es fundamental que se implementen
medidas para reducir el riesgo para los pacientes disminuyendo la probabilidad de que la funcionalidad del dispositivo se vea
comprometida, intencionada o involuntariamente, por una ciberseguridad inadecuada.

(1]

www.hologic.com/package-inserts
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SECCION 1
Introduccion
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Faxitron® Path

Sistema de radiografia de muestras

Este manual ha sido creado por Hologic, Inc. Tiene el objetivo de guiar al usuario avanzado 1.0.0
durante la configuracion, la instalacion y el uso del hardware Faxitron Path, asi como del ..
software Vision, ambos desarrollados por Hologic, Inc. Introduccion

Antes de utilizar el sistema, lea atentamente toda esta informacién. Siga todas las
advertencias y precauciones indicadas en este manual. Tenga este manual a mano durante
los procedimientos. Siga siempre todas las instrucciones de este manual. Hologic, Inc. no
asume la responsabilidad de las lesiones o los dafios derivados de un uso incorrecto del
sistema. Hologic puede organizar un curso de formacién en su centro.

Gracias de parte de todos los que integramos Hologic, Inc.

Fabricante e informacién de contacto

PROMOTOR DE AUSTRALIA

Hologic, Inc. Hologic (Australia and New Zealand) Pty Ltd

36 Apple Ridge Road Suite 302, Level 3

Danbury, CT 06810 EE. UU. 2 Lyon Park Road

1.800.447.1856 Macquarie Park NSW 2113

www.hologic.com Tel.: 02 9888 8000

[ Ec [REP] c €

Hologic, BV

Da Vincilaan 5

1930 Zaventem

Bélgica

Tel.: +322 711 46 80

Fax: +32 2725 20 87

En este manual y en el sistema de ayuda en linea, se utilizan los siguientes simbolos: 1.1.0
Simbolos de

Advierte al lector de una posible electrocucion en caso de que ignore la advertencia y
advertencia y utilice deliberadamente herramientas especificas para abrir una precaucion
cabina eléctrica precintada y manipular su contenido. &1 Nota: Hologic, Inc. no incluidos en este
proporciona ninguna herramienta. manual

Advierte al lector de una situacion de peligro. Por lo general, este simbolo va
acomparfiado de un simbolo mas especifico y de las instrucciones pertinentes
en cuanto a la naturaleza del peligro, el resultado esperado del peligro y la
informacion para evitarlo.

Advierte al lector de que debe tener cuidado al levantar equipos pesados para
evitar generar lesiones corporales y dafos al equipo.

Advierte al lector de que en el area etiquetada se emite una radiacion ionizada
cuando el haz de rayos X esta bajo tension. El sistema Faxitron Path dispone
de enclavamientos de seguridad que evitan que se acceda a la zona etiquetada
mientras el haz de rayos X esta bajo tension.

Advierte al lector que utilice la proteccion adecuada (como guantes quirtrgicos o
un recipiente autorizado para especimenes) con el fin de evitar la exposicién a
materiales potencialmente infecciosos, como las muestras de tejidos del paciente.

BB B >
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Sistema de radiografia de muestras

=

electrénicos de los desechos
normales. Envie el material
desmantelado a Hologic o
contacte con su
representante de atencion
al cliente.

Simbolo Descripcion Estandar
Para desecharlos, separe los | Directiva RAEE
dispositivos eléctricos y 2012/19/UE

Fabricante

1SO 15223-1,
referencia 5.1.1

Fecha de fabricacion

1SO 15223-1,
referencia 5.1.3

Radiacién ionizante 1SO 7010,
emitida cuando se activa el |referencia W003
haz de rayos X
Advertencia para utilizar  |1SO 7010,
proteccion adecuada referencia W009
Advertencia sobre IEC 60417,
electricidad referencia 6042
Advertencia 1SO 7010,
referencia W001

=B BB P

www.hologic.com/package-inserts

Consulte las instrucciones
de uso

1SO 15223-1,
referencia 5.4.3

O

Siga las instrucciones de
uso

IEC 60601-1,
referencia n.°

Tabla D.2, Serial de

seguridad 10
(ISO 7010-M002)

Este sistema transmite
energia de radiofrecuencia
(RF) (radiacion
electromagnética no
ionizante)

IEC 60417,
referencia 5140

1.1.1
Simbolos de
advertenciay
precaucion

en las etiquetas
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Faxitron® Path

Sistema de radiografia de muestras

Simbolo Descripcion Estandar
Representante autorizado | ISO 15223-1,
EC (REP en la Comunidad Europea |referencia 5.1.2

Producto sanitario

1SO 15223-1,
referencia 5.7.7

Ntimero de catalogo

1SO 15223-1,
referencia 5.1.6

Numero de serie

1SO 15223-1,
referencia 5.1.7

Pais de fabricacion

1SO 15223-1,
referencia 5.1.11

Traducciones en la caja

Hologic

Precaucién

1SO 15223-1,
referencia 5.4.4

Limite de humedad

1SO 15223-1,
referencia 5.3.8

LisTED

Intertek

Certificacién ETL

Consejo de
Normalizacién de
Canada

(SCO)y
Administracién de
Salud y Seguridad

Laboral de EE. UU.

(OSHA)

KonLy

Solo con receta

FDA 21 CFR
801.109

o

Corriente alterna

IEC 60417,
referencia 5032

C€

Marca CE

Conformidad europea

Reglamento MDR
(UE) 2017/745

A

Advertencia; haz laser

1SO 7010,
referencia W004
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Faxitron® Path

Sistema de radiografia de muestras

Simbolo

Descripciéon

Estandar

Bus serie universal (USB),
puerto/enchufe

ISO 7000-3650

Precaucion: radiacion Hologic
W (se producen rayos X)

Fusible IEC 60417,
_ referencia 5016

| Tierra IEC 60417-5017

Cuidado al levantar Hologic
objetos pesados

Nota Hologic

X

HOLOGIC

MANUAL DE USUARIO DE FAXITRON PATH | HOLOGIC | REVISION 001

1-5



Faxitron® Path SECCION 2

Sistema de radiografia de muestras configuracién

SECCION 2
Instalacion y configuracion
de Faxitron Path
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Faxitron® Path SECCION

Instalacién y

Sistema de radiografia de muestras configuracion
Advertencias 21.0
e Antes de utilizar el sistema, lea atentamente las instrucciones. Advertencias y
¢ No utilice el sistema de manera distinta a la del uso previsto, tal y como se describe en p_recaucmnes del
este manual. En caso de duda, pongase en contacto con Hologic o con el distribuidor sistema
autorizado.

¢ No todos los cables de alimentacién tienen la misma clasificacién. No utilice con este
sistema ningun otro cable de alimentacion que no sea el suministrado. No utilice el cable
de alimentacion de este sistema en ningun otro equipo.

e Este sistema ha sido probado siguiendo las normas internacionales mas estrictas; no
obstante, en lo relativo a los requisitos operativos locales es recomendable que se ponga
en contacto con las autoridades nacionales.

o Este sistema no esta destinado al uso publico. Debera estar situado en una zona en la
que el publico en general no pueda acceder al sistema sin la presencia de un operador.

Precauciones generales
Para evitar producir dafios al sistema Path, deberan tomarse las siguientes precauciones:

e Mientras el sistema de camara esté encendido, nunca conecte ni desconecte los cables
de comunicacion y/o alimentacion. Si los cables se conectan o desconectan mientras la
camara esta encendida, podran producirse dafios en el sensor CMOS o en los
componentes electrénicos de la camara.

¢ El sistema de camara es fragil y se debe tener cuidado para no dafarlo. El sistema de
camara nunca se debera manipular incorrectamente, golpear bruscamente, golpetear ni
dejar caer.

e El sistema Path dispone de un modo de calibracion. Para garantizar el correcto
funcionamiento del sistema, la calibracion debera llevarse a cabo diariamente. Consulte el
Procedimiento de calibracion.

e Precaucion: El uso de controles o los ajustes para realizar procedimientos distintos de los
especificados en el presente documento podra provocar la exposicion peligrosa a la
radiacion.

Conexiones interoperativas

El Path es capaz de funcionar como un dispositivo auténomo, sin entradas ni salidas hacia
otros dispositivos. En el sistema, las imagenes se pueden captar, almacenar y revisar
directamente.

Sin embargo, el sistema dispone de varias interfaces. La principal es la conexion de red
que permite conectar el sistema a un sistema de archivo y comunicacion de imagenes
(SACI). Las imagenes pueden ser transmitidas en formato DICOM desde el dispositivo
directamente a la red del centro a través de nuestro software. Para obtener mas detalles
sobre la versién de DICOM, consulte la seccion 6. Solamente deberan configurar esta
comunicacion los empleados de Hologic o el personal de Tl capacitado del centro del
usuario.

A continuacién, se enumeran las conexiones del sistema y el uso previsto. Ningun otro tipo
de dispositivo debera conectarse al Path sin la aprobacion de Hologic.

HOLOGIC
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Faxitron® Path

Sistema de radiografia de muestras

SECCION
Instalacién y
configuracion

Conexioén

Propésito

Tipo de dispositivo

Usuarios a los que va dirigido

Puerto
Ethernet de la
parte posterior

Almacenar imagenes radiograficas en un
sistema de almacenamiento de datos en
red.

SACl o
almacenamiento en
red

Configurado por el personal de
Hologic o de Tl del centro.
Utilizado por profesionales clinicos.

Puerto
Ethernet de la
parte posterior

Permitir la conexion remota por parte del
equipo de mantenimiento de Hologic
para que Hologic pueda diagnosticar y
reparar el sistema.

Conexion a Internet
en red

Personal de Hologic o de Tl del
centro.

Puerto USB de
la parte frontal

Transferir imagenes desde el dispositivo.
Este solamente se debera utilizar si el
SACI o la red no estan disponibles.

Dispositivo de
almacenamiento
USB (memoria flash)

Profesionales clinicos o de Tl que

tenga acceso autorizado al sistema.

Puerto USB de
la parte frontal

Mantener y conservar los archivos del
sistema; es posible que sea necesario
copiarlos en y desde el ordenador. Por

Dispositivo de
almacenamiento
USB (memoria flash)

Personal de Hologic o de Tl del
centro.

ejemplo, actualizaciones de software o
archivos de registro.

Permitir la conexion de una impresora. El
software Vision permite la conexion de
una impresora DICOM o una impresora
estandar compatible con Windows.

Profesionales clinicos o de Tl del
centro.

Puerto USB de
la parte
posterior

Impresora DICOM o
Windows

Ciberseguridad 2.1.0 Cont.

La seguridad de los dispositivos es una responsabilidad compartida entre Hologic y los
centros médicos. Si no se mantiene la ciberseguridad, se podrd poner en peligro la
funcionalidad del dispositivo, la disponibilidad o la integridad por la pérdida de los datos
(médicos o personales), o la exposicién a amenazas de seguridad de otros dispositivos o
redes conectados. Para asegurar la ciberseguridad de sus unidades y conservar su
funcionalidad y seguridad, Hologic mantiene una serie de controles de ciberseguridad.

Todas nuestras unidades utilizan el sistema operativo estandar de Windows. Durante la
instalacion, recomendamos que el centro implante todas las medidas de seguridad que sean
necesarias y estén definidas por sus propios requisitos internos, como lo haria con cualquier
otro PC conectado a la red.

El centro podra configurar el sistema operativo Windows con todos los protocolos de red y
permisos necesarios. Por ejemplo, podra anadir:

» Identificaciones (ID) y contrasefas de usuarios,

* autorizacion por niveles con la autenticacion correspondiente,

. restricciones a la instalacion del software,

*  requisitos de contenido de confianza, incluida la verificacion del codigo de la firma,

«  configuracion de las actualizaciones de Windows, incluidas las versiones de seguridad.
Ademas, nuestro software de imagenes (Vision) se puede proteger mediante contrasefia

para que determinados usuarios puedan acceder al sistema operativo sin tener que abrir el
software Vision.

La unidad viene con una llave fisica que enciende el sistema de rayos X. Esto permite que
el sistema se bloquee, por lo que incluso si se accede al software no se pueden iniciar los
rayos X.

Esta unidad esta disefiada para utilizarse como unidad independiente o conectarse al SACI
interno del centro o a otra red de circuito cerrado. No estéa previsto que se conecte a Internet,
a menos que: (a) el centro reciba de Hologic instrucciones especificas para hacerlo, o (b) el
centro tome las precauciones adecuadas que garanticen la ciberseguridad de la unidad
frente a las amenazas relacionadas con la conexién a Internet.

Para seguir garantizando la seguridad del producto segun sea necesario durante todo el
ciclo de vida de la unidad, Hologic desarrollara actualizaciones o parches para el software
Vision.

HOLOGIC
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Faxitron® Path

Sistema de radiografia de muestras

SECCION
Instalacién y
configuracion

Se podran implementar medidas de seguridad adicionales, incluido el cifrado, y Hologic
podra trabajar con el departamento de Tl de los centros para reducir el riesgo de los
pacientes como resultado de una violacion de la ciberseguridad.

Limpieza
Compartimento interno

Las muestras que contienen especimenes biolégicos pueden albergar agentes infecciosos
que son peligrosos para la salud. Siga los correspondientes procedimientos de
bioseguridad; cuando manipule especimenes de tejido o cualquier material con el que entren
en contacto, utilice guantes.

Limpie periddicamente el interior del armario con alcohol isopropilico al 70-90 % o hipoclorito
de sodio diluido (la lejia doméstica al 5,25 %-6,15 % diluida en la proporcién 1:500 ofrece la
concentracion adecuada). Asegurese de que el area de especimenes, marcada en la base
de la camara, esté bien limpia.

Compartimento externo

Limpie periddicamente las superficies exteriores con alcohol isopropilico, hipoclorito de
sodio, 0 agua con jabon suave (consulte mas arriba las concentraciones correspondientes).
No empape ni inunde las superficies, ni utilice abrasivos que puedan rayarlas. No permita
que la humedad entre en contacto con ninguno de los componentes eléctricos del sistema.
Para verificar que no deterioran el acabado, pruebe los productos de limpieza en un area
pequefa y poco visible de las cubiertas metalicas y de plastico.

2.1.0 Cont.

/2\
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Faxitron® Path

Sistema de radiografia de muestras

SECCION

Instalacién y
configuracion

Inspeccion de las cajas

El sistema Faxitron Path se presenta en dos cajas, una de ellas una caja de madera de
grandes dimensiones. Solicite al transportista las lleve a un area donde puedan mantenerse
a salvo de robos, dafios o condiciones ambientales extremas hasta que el representante
autorizado de Hologic pueda instalar el sistema.

Compruebe que no estén dafadas. Si cualquiera de ellas parece estar dafiada, pongase en
contacto con Hologic llamando al +1 -800-447-1856.

La caja de madera mide alrededor de 4 pies (1,2 m) de alto. Contiene la unidad de
especimenes, un ordenador y los manuales del sistema. La otra caja contiene el monitor del
sistema.

Elevacion y transporte de las cajas de madera

Precaucion: La caja pesa aproximadamente 550 libras (250 kg). El sistema embalado debe
mantenerse en posicion vertical, como aparece indicado en la caja del envio.

Desempaquetado y montaje del sistema

El sistema Faxitron Path debe desembalarse y configurarse por un representante autorizado
de Hologic, Inc.

Ubicacion
La ventilacion y el conector de alimentacion del sistema Faxitron Path se encuentran en la
parte posterior de la cabina. Para permitir que el aire circule adecuadamente y que el usuario

pueda desconectar el cable de alimentacion, cuando instale la unidad deje al menos
6 pulgadas (15 cm) de espacio libre detras de la misma.

2.2.0
Config

uracion

del sistema Path

de Fax

Jia

itron
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Faxitron® Path SECCION

Sistema de radiografia de muestras Configuracién
Condiciones ambientales 2.3.0
Operativas: Especificaciones

Temperatura: entre 15,5y 30 grados C (entre 60 y 86 grados F).
Humedad relativa: <75 %.

Almacenamiento y transporte:
Temperatura: entre 0 y 45 grados C (entre 32 y 113 grados F).
Humedad relativa: <75 %.

Este equipo esta disefiado para funcionar en las siguientes condiciones:

e Uso en interiores

e Altitud hasta 6562 pies (2000 metros)
e Contaminacién de grado 2

e Categoria de sobretension |l

Una vez instalado, el Faxitron Path no debe moverse. El sistema fue disefiado como un
sistema estacionario para ser instalado en un mostrador o mesa.

PROTECCION RADIOLOGICA

e Armario con proteccion frente a radiacion.
e Puerta del compartimento equipada con enclavamientos de seguridad dobles.

e Radiacion: por debajo de 0,1 mR/h (1 ySv/h) a 5 cm (2 pulgadas) de la superficie exterior
al méaximo voltaje.

e Garantia de cumplimiento de las normas establecidas por el Centro de Aparatos y Salud
Radiolégica de la Administracion de Alimentos y Medicamentos de los Estados Unidos,
(21 CFR 1020.40).

e Disefiado conforme a las normas fijadas por Underwriters Laboratories (EE. UU. y
Canada).

e Hologic recomienda que los usuarios reciban formacion basica en seguridad frente a la
radiacion ionizante antes de utilizar el sistema.

CONTROL DE LA EXPOSICION: automatico o manual.

CICLO DE TRABAJO DE LOS RAYOS X: 50 %

INFORMACION DEL LASER: producto laser de clase 1
IEC 60825-1 Ed. 2

De acuerdo con las normas 21 CFR 1040.10 y 1040.11,
a excepcion de las desviaciones contempladas en el aviso
sobre laser n.° 50 del 24 de junio de 2007.

REQUISITOS DE POTENCIA: méaximo de 100-250 VCA, 50/60 Hz, 200 VA
POTENCIA CALORIFICA: maximo de 500 BTU/h (527,5 kJ/h)
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Faxitron® Path

Sistema de radiografia de muestras

SECCION
Instalacién y
configuracion

) 2.3.0 Cont.
DIMENSIONES EXTERNAS (aproximadas)
cm pulgadas
Altura 90 36
Anchura 59 23
Profundidad 54 21
DIMENSIONES INTERNAS DEL COMPARTIMENTO (aproximadas)
cm pulgadas
Altura 57 22,3
Anchura 39 15,5
Profundidad 42 16,5
PESO (aproximado)
Con ordenador, monitor, teclado y accesorios
kg Ib
Neto 210 465
Del paquete 258 570
Solo el armario
Neto 188 415
Del paquete 236 520
23" 21"
59 cm 54 cm
r: @ :I ” IIIIIIIEIWIHH:ED]]III
g | w1
|
|
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Faxitron® Path SECCION 3

Sistema de radiografia de muestras de la camara

SECCION 3
Calibracion de la camara
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Faxitron® Path SECCION

Sistema de radiografia de muestras de la cadmara

Calibracién 3.1.0

En el momento de la puesta en marcha inicial del sistema, o en cualquier momento deseado ~ Calibracion
por el usuario, se podra realizar la calibracién del sistema. Tras la puesta en marcha inicial y
transcurrido un periodo de doce (12) horas, deben realizarse las siguientes calibraciones.

Para optimizar la calidad de las imagenes, el software Vision y el hardware requieren la
realizacién periédica de la calibracion. Esta calibracién requiere la obtencion de imagenes de
referencia. Dichas imagenes se pueden agrupar en tres (3) categorias: imagenes
desplazadas, imagenes oscuras e imagenes de campo plano.

El software Vision se abrira directamente en Home Menu (Menu de inicio; Figura 3.1.1)
o en la pagina Calibration (Calibracion; Figura 3.1.2) dependiendo del tiempo
transcurrido desde la ultima calibracion del sistema. Para iniciar manualmente una
calibracion, dirijase a la pagina Calibration (Calibracién).

A Precaucion: Antes de iniciar la calibracion, verifique que el compartimento esté vacio.

Para iniciar manualmente una calibracion, haga clic en el boton «Calibrate» (Calibrar) de
Home Menu (Menu de inicio).

Figura 3.1.1
Botén Calibrate para calibrar el
sistema
Start Procedure
()
Review Shut Down

A continuacion, se pedira la confirmacion del usuario mediante la seleccion de «Start

Calibration» (Iniciar calibracion).
Figura 3.1.2

Mensaje Start Calibration para
iniciar la calibracion

Start Calibration

Last Calibrated: 201 7/31 14:41:53 Tue

ENSURE THE CHAMBER IS EMPTY BEFORE CALIERATION

Calibration before beginning any procedure is recommended

Cuando pulse, se llevara a cabo el proceso de calibracion y se mostrara un cuadro de mensaje
de la misma. Durante la calibracion, el cuadro de mensaje alternara entre «<SYSTEM IN
CALIBRATION» (SISTEMA EN CALIBRACION) y «X-RAY ON» (RAYOS X ENCENDIDOS).
Véase la Figura 3.1.3.

Figura 3.1.3

Era— R

Calibrating

‘i‘ SYSTEM IN CALIBRATION

El software volvera de forma automatica al Home Menu (Menu de inicio) cuando se complete
la calibracion.

Para obtener mas informacién sobre la calibracion, consulte las secciones 5.2.0 y 5.2.1.
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Faxitron® Path SECCION 4

Sistema de radiografia de muestras Inicio répido

SECCION 4

Inicio rapido:
funcionamiento basico de
Faxitron Path
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Faxitron® Path SECCION

Sistema de radiografia de muestras Inicio répido

Antes de encender el sistema, asegurese de que todos los cables estén bien enchufados en 41.0
el sistema, el ordenador y el monitor. Inicio répido

Consulte la seccién 2 de este manual, Instalacion y configuracion, y las guias de
configuracion rapida y de inicio rapido suministradas con el sistema Path.

Figura 4.1.1
Panel frontal de Faxitron Path

Tecla de
encendido/
apagado

Protocolo de la secuencia de puesta en
marcha del sistema

Para garantizar que el funcionamiento del sistema y la calidad de las imagenes sean los
adecuados, debera seguirse esta secuencia de puesta en marcha:
Sistema de encendido

e Coloque el interruptor de alimentacion de la parte posterior del armario Path en la
posicion «ON» (Encendido).

e Gire lallave de contacto de la parte frontal del armario Path hasta «ON» (Encendido)
(en el sentido de las agujas del reloj a la posicion de las tres).

e Encienda el ordenador y el monitor.

Inicio del soft
nicio del software Figura 4.1.2

e Compruebe que no haya nada en el compartimento de rayos X del Icono de escritorio de Vision
Path.

e El software Vision deberia iniciarse automaticamente cuando el
sistema operativo Windows haya terminado de arrancar. Si el
software no se inicia automaticamente, haga doble clic en el icono
de Vision que se encuentra en el escritorio de Windows.

Calibrar

e Enel momento de la puesta en marcha inicial del dia el software deberia abrirse en
la pagina Calibration (Calibracién).

e Presione el botén «Calibrate» (Calibrar) y permita que el sistema complete la calibracion.

Recomendaciones extra para obtener una calidad de imagen optima.

Cada dia, antes de comenzar a utilizar el sistema, permita que se realice una calibracion
completa en el mismo. El sistema esta configurado para realizar dicha calibracion en el
momento en que inicie el software Vision.

Después de trasladarlo a otra habitacién, lleve a cabo una calibracién completa del sistema
para evitar posibles problemas en la obtencidon de imagenes relacionados con las diferencias
de temperatura y humedad ambiente entre las habitaciones.
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Faxitron® Path SECCION

Sistema de radiografia de muestras Inicio répido
Procedimientos basicos de obtencién de imagenes 4.2.0
. : . . Obtencion de

Advertencia: El uso de Path de una manera diferente a la descrita en este manual podria ..
provocar un mal funcionamiento del equipo o lesiones personales. Imagenes
Advertencia: Para evitar el contacto con muestras de tejido de pacientes que sean
potencialmente peligrosas, utilice recipientes o guantes autorizados.
Start Procedure (Iniciar procedimiento)

e En la pagina Home Menu (Menu de inicio), seleccione el botéon Start Procedure

(Iniciar procedimiento).
Figura 4.1.3

Home Menu (Menu de inicio)
del programa Vision (pantalla

principal)
Start Procedure
—— |
> ®@ O
Review Help Shut Down
e Al usuario se le daran las opciones Select from Work List (Seleccionar en la lista
de trabajo), Manual Entry (Introduccién manual), Select from Database
(Seleccionar en la base de datos) o Continue with current patient (Continuar con
el paciente actual).
e Para introducir manualmente un nuevo procedimiento, seleccione el boton Manual
Entry (Introduccién manual).
Figura 4.1.4
< Opciones de Start Procedure
(Iniciar procedimiento)

Continue with current patient Select from Database E
Camarated G034

e Se abrira el cuadro de didlogo «Patient Information Editor» (Editor de la informacion
sobre el paciente).
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Faxitron® Path

Sistema de radiografia de muestras

SECCION

Inicio rapido

Patient Name: *

Patient ID: Ll JD12
Accession #: t N 123456789

Date of Birth: 1920/03/16

Sex:

Procedure Name:

Laterality:

%*

12 |
E
T
¢
¢
¢
¢
S
I
I
|
|

>

Position View:
Body Part:
Refer. Physician:
Technician:

Technician ID:

Study Name:

Study ID:

Accept

< Start a New Patient or Procedure

& Nota: Los campos obligatorios aparecen indicados con un
asterisco blanco (*).
Los campos obligatorios y predeterminados son: Patient Name

(Nombre del paciente), Patient ID (Identificacion del paciente),
Accession Number (Numero de ingreso) y Laterality (Lateralidad).

e Introduzca todos los campos obligatorios. Si falta algin campo obligatorio, el botén
Accept (Aceptar) no estara activo. El usuario podra completar otros campos si lo desea.

& Nota: La fecha de nacimiento debera introducirse como aaaa/mm/dd (por ejemplo,
1962/08/13).

e Para activar la obtencién de imagenes, seleccione Accept (Aceptar).

Obtencion de imagenes de rayos X

Coloque los especimenes en un recipiente para especimenes proporcionado por Hologic,
Inc. o su institucion, y péngalo dentro del compartimento de rayos X Path. El area de
obtencion de imagenes estd marcada con una banda adhesiva del contorno (el usuario
también puede colocar el espécimen y el recipiente en la bandeja de aumento suministrada
con el sistema Path).

Pulse el botdn verde Start X-ray (Comenzar radiografia) del software o de la parte frontal
de la cabina de rayos X para iniciar la obtencién de imagenes o radiografias.

Espere a que se visualice la imagen.

A% Nota: Si el modo Full Auto (Totalmente automatico) esta seleccionado, se realizaran
dos radiografias; la primera, para determinar los mejores ajustes, y la segunda para obtener
la imagen. Los ajustes utilizados durante la exposiciéon (kV y tiempo) se mostraran en la
pantalla LCD de los armarios.

4.2.0 Cont.

Figura 4.1.5

Pantalla Patient Data (Datos

del paciente)
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Faxitron® Path SECCION

Sistema de radiografia de muestras Inicio répido
El software Vision esta configurado para guardar automaticamente la imagen en la base de 4.2.0 Cont.
datos de Faxitron, en la unidad local del ordenador del sistema. El usuario también puede
guardar la imagen en el servidor de instalaciones haciendo clic en el icono PACS (SACI).
Véase la Figura 4.1.6.
Figura 4.1.6

Faxitron

Pantalla de la imagen

Para obtener mas informacion sobre como ajustar la configuracion de las imagenes, los
controles de rayos X y las opciones de revision y guardado, consulte la seccioén 5.

HOLOGIC
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Faxitron® Path SECCION 5

Software
Sistema de radiografia de muestras VISION

SECCION 5
Funcionamiento del
software VISION
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Faxitron® Path

Sistema de radiografia de muestras

SECCION

Software
VISION

El software Vision es un completo paquete de obtencién y procesamiento de imagenes que
esta disefado exclusivamente para trabajar con los generadores de rayos X de Faxitron (como
los sistemas VersaVision, Faxitron Path, CoreVision y BioVision). Ademas de las funciones de
obtencion y procesamiento, el software ofrece un amplio médulo de base de datos que permite
el control y el mantenimiento de archivos y el almacenamiento, la tramitacion y la recuperacion
de las imagenes por parte del usuario. El software también es compatible con Imagenologia
Digital y Comunicaciones en Medicina (DICOM), lo que permite guardar e imprimir imagenes
de los pacientes en formato DICOM 3.0. El software ha sido preinstalado en el ordenador que
se incluye con el sistema de rayos X.

Para obtener la mejor calidad de las imagenes, sera necesario calibrar el sistema cada nuevo
dia de uso. Para garantizar que la calidad de las imagenes sea 6ptima, el usuario del sistema
también podra realizar la calibracién en cualquier momento.

Después de la calibracion, se mostrara el Menu de inicio, que permite navegar al resto de areas
del software. Para facilitar el uso, se proporcionan botones de aplicacion. Véase la Figura 5.0.1.
Estos botones estan en el centro de la pantalla. Las descripciones y definiciones de los botones
aparecen explicadas en las préximas secciones de este manual.

Start Procedure

Calibrate

2007/07/31 14:41:53 Tue

>

Review Shut Down

Protocolo de la secuencia

Para garantizar que la funcionalidad del sistema y la calidad de las imagenes sean las
adecuadas, debera seguirse esta secuencia de puesta en marcha:

Encienda el armario Faxitron Path mediante el interruptor situado en su parte posterior
(el interruptor de alimentacién esta junto a la toma de corriente del cable de alimentacion).
Pulse «I» para kENCENDERLO» y «0» para «<APAGARLO».

Encienda el armario Faxitron Path introduciendo la llave Faxitron Path en el interruptor de
cerradura con llave, situado en el panel frontal, y girdandola en el sentido de las agujas del reloj

hasta la posicion de las tres. A Nota: La llave no se puede extraer en esta posicién.
Encienda el ordenador y el monitor.

El software Vision se iniciara automaticamente cuando Windows haya
completado su secuencia de arranque. Aparecera brevemente un cuadro de
dialogo para indicar que el software se ha inicializado y esta cargado.

Nota: Si Vision no se inicia automaticamente, haga doble clic con el
botdn izquierdo del raton en el icono del software Vision (ubicado en el
escritorio de Windows). Véase la Figura 5.1.1.

El software Vision se abrira en Home Menu (Menu de inicio) o en la pagina Calibration
(Calibracion), dependiendo del tiempo transcurrido desde la ultima calibracién del sistema.

Para obtener informacion sobre los protocolos de calibracién, consulte «Calibracion de la camara»
en la seccion 3 y «Descripcidon general de la calibracion de la cdmara», en la seccién 5.2.1.

5.0.0
Descripcion
general del
software Vision

Figura 5.0.1
Home Menu (Menu de inicio) del
software Vision (pantalla de inicio)

5.1.0
Puesta en marcha
del software

Figura 5.1.1
Icono de escritorio del software
Vision
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Faxitron® Path SECCION

Software
Sistema de radiografia de muestras VISION
Introduccion a la calibracién 5.2.0

-~ : - . , Descripcion
Para optimizar la calidad de las imagenes, el software Vision y el hardware requieren la Idel
realizacién periodica de la calibracion. Esta calibracion requiere la obtencion de imagenes de ger_‘era ) ’e a
referencia. calibracion de la

En el momento de la puesta en marcha inicial del sistema, o en cualquier momento deseado camara

por el usuario, se podra solicitar y realizar la calibracion del sistema. Se recomienda que,
transcurrido un periodo de doce (12) horas, se realicen las siguientes calibraciones.

Estas imagenes de calibracion de referencia se utilizan para calibrar, pixel por pixel, una
imagen de rayos X «sin procesar» con el fin de generar una imagen «corregida», que sera
visualizada. Las correcciones realizadas a la imagen abarcan correcciones de ganancia,
contraste y linealidad.

Secuencia de la calibracion

Para mayor comodidad, el software Vision combina los numerosos pasos de calibraciéon en un
solo paso unificado.

Cuando un sistema Faxitron de rayos X ha estado apagado durante mas de doce (12) horas,
el sistema solicitara automaticamente que se vuelva a calibrar. Se recomienda
encarecidamente que el sistema se vuelva a calibrar tras periodos prolongados de inactividad
o después de que el sistema se traslade de una estancia a otra que tenga unos parametros de
temperatura o humedad ambiente potencialmente diferentes.

Para calibrar el sistema en cualquier momento, haga clic en el botdn Flgyra 5'2.'1 .
Calibrate (Calibrar) en Home Menu (Start-up Screen) (Menu de inicio BOt.OI.' Qallbrate del mend
[Pantalla de puesta en marcha)) de Vision y, a continuacioén, presione de inicio

Start Calibration (Iniciar calibracion). Véanse las Figuras 5.2.1y 5.2.2.
Durante la calibracion, el didlogo mostrara un mensaje de estado.
Véase la Figura 5.2.3. Calibrate

2007/07/31 14:41:53 Tue

Figura 5.2.2

Botén Start Calibration para
iniciar la calibracién

Start Calibration

Last Calibrated: 20f 31 14:41:53 Tue

Calibration before beginning any procedure is recommended

Figura 5.2.3
Estado de la calibracion

Calibrating

‘5‘ SYSTEM IN CALIBRATION

Durante la calibracién, puede que se generen rayos X. Durante la generacién de rayos X, se
hara visible el botén Stop X-Ray (Detener rayos X) para permitir que el usuario tenga la opcién
de detener los rayos X utilizando el software.
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Faxitron® Path SECCION

Software
Sistema de radiografia de muestras VISION

Periédicamente, convendria incorporar las caracteristicas de atenuacion de los rayos X de un 521
atenuador uniforme en las imagenes de calibracion de referencia de campo plano. Por ejemplo, Calibraciéon
si todos los objetos radiografiados se colocan sobre una placa plastica delgada, las
caracteristicas de atenuacion de los rayos X de la placa se observaran en cada imagen avanzada
obtenida. En este caso, la colocacién de la placa dentro del haz de rayos X durante la obtencion

de la imagen de calibracion de referencia de campo plano podria mejorar la calidad de las

imagenes. A continuacion se presenta un resumen del protocolo de calibracion avanzada para

«ambos» (el campo plano y la imagen):

Coloque el atenuador uniforme sobre el sensor. Toda la superficie del sensor debera estar
cubierta por el atenuador. Para obtener resultados ideales, el atenuador deberd ser mayor que
el area de obtencién de imagenes del sensor.

Para enfocar el menu, desde la pantalla de puesta en marcha del software de obtencion de imagenes,

presione el icono A situado en la parte superior derecha. En el menu horizontal situado en la parte
superior de la pantalla, seleccione el elemento «Tools» (Herramientas) del menu desplegable y, a
continuacién, vaya hasta «Advanced Tools» (Herramientas avanzadas) y, después, a «X-Ray
Calibration/Exposure Setup» (Calibracion de rayos X/Configuracion de la exposicion).

X-ray Generator and Exposure Settin (&) Figura 5.2.4
2 : - Generador de rayos X y cuadro
~ GEMERATOR SETTINGS — - EXPOSURE SETTINGS de dialogo de la exposicion

kv Current SET SetFor  (¥ay Cal (FlatField) (O Manuallmage @ Bath
- Test Exposure User Time/ADU Target
mé Current | 1000

Time[g] | 200 ‘ Select O Time @ADL ‘
; 280 .

ki srap Cal ADlse | 15326 T ] |4_?5 | ADU |snuu.n |

:{n\-..fag: e Acquire E stimate/Calculate

AUTOMATIC EXPOSURE COMTROL [OM THE FLY]

tMagrification -| .0o0
AEC Mode for Image ON [TARGET =Image 0L

- NUMBER OF CAL IMAGES —————— | AEC Mode for FlatField DN [TARGET =Flat-Field 40U
#-ray Cal [Flat-Field) Averages
v LAl ] & TEHIEET wilEE reaehed By EEsitaut e Garstraiit
— IMAGING MODE

E.&ppl}l tanual Imaging Settings On Exit, Disengage Preshot

[ Acoept Settings ] [ Cancel ]

& Nota: Los valores de kV, el tiempo de exposicion y las unidades
analdgico-digitales (UAD) podrian ser diferentes de los mostrados.

e En «X-Ray Generator and Exposure Settings» (Ajustes del generador de rayos X y la
exposicion), introduzca el ajuste de kV del generador en el campo correspondiente.

¢ Ajuste la «Magnification» (Ampliacion) o deje el uno (1.0) como ajuste predeterminado.
¢ En el cuadro de dialogo, seleccione el boton «Set for» (Ajustar para) «Both» (Ambos).

e En «user ADU target» (blanco de las UAD del usuario), deje el ajuste predeterminado. La
exposicion a los rayos X se interrumpira cuando el sensor haya acumulado un nivel medio de
sefial de UAD que sea aceptable para el generador de rayos X que usted tiene.

¢ Deje el tiempo de exposicion predeterminado de la prueba y haga clic en el botéon Acquire
(Obtener). El sistema dara inicio automaticamente a los rayos X y obtendra una imagen.

e Cuando la exposicion a los rayos X haya finalizado, haga clic en el botéon Estimate/Calculate
(Estimar/Calcular).

¢ Registre la lectura del tiempo de exposicién «Time[s]» (Tiempo[s]) calculado. El sistema
calculara este tiempo y el nUmero aparecera en gris.
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Faxitron® Path

Sistema de radiografia de muestras

SECC

ION

Software

VISION

e Introduzca la lectura del tiempo de exposicion «Time[s]» (Tiempo[s]) calculado en la casilla
de tiempo «Test Exposure» (Exposiciéon de prueba). Para dar inicio automaticamente a los
rayos X y obtener una imagen, presione el boton Acquire (Obtener).

¢ Cuando la exposicion a los rayos X haya finalizado, haga clic en el botén Estimate/Calculate
(Estimar/Calcular).

¢ Registre la lectura del tiempo de exposiciéon «Time[s]» (Tiempo[s]) calculado.

¢ Vuelva a introducir la lectura del tiempo de exposicién calculado en la casilla de tiempo «Test
Exposure» (Exposicion de prueba).

¢ Haga clic en el botén Accept Settings (Aceptar configuracion).

¢ Realice un procedimiento estandar de calibracién, tal y como se describe en la seccién
«Descripcion general de la calibracion de la camara.

Como se describio anteriormente, puede que los usuarios experimentados quieran ajustar «X-
Ray Cal (Flat-Field)» (Calibracion de rayos X [Campo plano]) y «Manual Image» «Exposure
Settings» (Imagen manual) (Ajustes de la exposicion) por separado o «Both» (Ambos) (el
campo plano y la imagen manual). Seleccionando el botén de opcién «Flat Field» (Campo
plano), el sistema determinara el tiempo de exposicidon 6ptimo para obtener imagenes de
campo plano al nivel de UAD deseado. Por consiguiente, la seleccion de «Manual Image»
(Imagen manual) determinara el tiempo de exposicion 6ptimo para el sistema con un objeto
que atenue la sefial de rayos X. Para obtener los mejores resultados, el objeto debera cubrir
toda el &rea de obtencion de imagenes del sensor.

Después de seleccionar «X-Ray Cal (Flat-Field)» (Calibracion de rayos X [Campo plano]) y
«Manual Image» (Imagen manual) y de haber ajustado el nivel de UAD, seleccione el botén
Acquire (Obtener). Para seleccionar «Manual Image» (Imagen manual), conviene tener el
objeto o el atenuador de rayos X en el haz de rayos X. Para generar rayos X y obtener una
imagen, pulse el boton Acquire (Obtener). Cuando la exposicion a los rayos X haya finalizado,
haga clic en el botdon Estimate/Calculate (Estimar/Calcular). El sistema calculara el tiempo
optimo, y el nimero aparecera en gris. Para guardar los «Exposure Settings» (Ajustes de
exposicion) en el archivo de configuracion del sistema, haga clic en el boton Accept Setting

(Aceptar ajuste). /% Nota: Solamente se guardaran los ajustes del botén de opcion que
haya seleccionado. A continuacion, realice un procedimiento estandar de calibracion, tal y
como se describe en la seccidn «Descripcion general de la calibraciéon de la camaray.

El boton Start Procedure (Iniciar procedimiento; véase la Figura 5.0.1) lleva al usuario a la
pagina Patient Data Entry (Introduccion de datos del paciente), que proporciona métodos para
introducir los datos de los pacientes. Si no se ha configurado una lista de trabajo, la opcién
aparecera en gris y solamente se podra acceder a las opciones Continue with Current Patient
(Continuar con el paciente actual), Manual Entry (Introduccion manual) y Select from
Database (Seleccionar en la base de datos). Las opciones aparecen explicadas en las
siguientes secciones.

Select from Work List

>

Continue with Current Patient CelachfroriDatabace E
JANE DOE

5.2.1 Cont.

5.3.0

Datos del paciente

Figura 5.3.1

Pantalla Introduccion de datos

del paciente
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Faxitron® Path

SECCION

Software
Sistema de radiografia de muestras VISION
SELECCIONAR EN LA LISTA DE TRABAJO 5.3.1

(lista de trabajo de modalidad remota)

Si se ha configurado una lista de trabajo, el usuario podra hacer clic en el botén Select from
Work List (Seleccionar en la lista de trabajo), que mostrara la siguiente pagina. Véase la
Figura 5.3.2 a continuacion.

Search Parameters: sy

hhhhhh

2019/03/28

FAXITRON_DR

_ & Nota: Todos los datos de los

pacientes son ficticios.
Cualquier parecido con personas

reales es pura coincidencia.

A laizquierda hay varios filtros que pueden utilizarse para buscar procedimientos programados
para la aplicacién de la terminal (AE). Verifique que esté definido el titulo AE de la terminal; a
continuacion, cualquier campo individual o cualquier combinaciéon de campos podra utilizarse
como filtro para buscar procedimientos programados para este AE. Seleccionando el botén
Query (Consulta) situado en la esquina inferior izquierda, la tabla se rellenara con las entradas
que coincidan con la informacién consultada.

El usuario podra entonces hacer clic en cualquier entrada y pulsar Submit (Enviar) para rellenar
automaticamente el editor de la informaciéon sobre la obtencién de imagenes con la informacion
del paciente.

AVISO: El usuario también podra hacer doble clic en cualquier entrada de la tabla para acceder
rapidamente al editor de la informacion sobre la obtencién de imagenes sin tener que presionar
Submit (Enviar).

Se abrira el editor de la informacion sobre la obtencion de imagenes Patient Information Dialog
(Dialogo de informacion sobre el paciente). Véase la Figura 5.3.3. Para proceder a la obtencién
de imagenes, rellene el resto de los campos obligatorios y haga clic en Accept (Aceptar).

Seleccionar en la
lista de trabajo

Figura 5.3.2
Dialogo de busqueda en la lista
de trabajo de la modalidad
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Faxitron® Path

Sistema de radiografia de muestras

SECCION
Software
VISION

& Nota: Los campos obligatorios aparecen indicados con un asterisco blanco (*). Los campos
obligatorios y predeterminados son: Patient Name (Nombre del paciente), Patient ID
(Identificacion  del paciente), Accession
Number (Numero de ingreso) y Laterality
(Lateralidad). Patient Name: 4 [ foee |
Antes de poder seleccionar el boton Accept Patient ID: - JD4567

(Aceptar), el usuario debera introducir todos los
campos obligatorios. Si asi lo desea, el usuario
también podra introducir los campos Date Date of Birth: 1920/03/20
(Fecha), Referring Physician (Médico remitente),
Procedure Name (Nombre del procedimiento),
Sex (Sexo), Technician (Técnico), Position View
(Vista de la posicién), Body Part (Parte
anatémica) y Study ID (ldentificacion del loceduialiiare:
estudio). El nombre del procedimiento, la vista de
la posicion y la parte anatomica se eligen
mediante un menu desplegable. Position View:

Accession #: LN 918273

Sex:

Laterality:

*

=
AV 4 «

Body Part:
&Nota: La fecha debera indicarse como
aaaa/mm/dd (por ISTnlo)[oMl  Refer. Physician:
1962/08/13). Si no se introduce la Technician:
fecha valida, se podran producir
errores al intentar recuperar las [EchniziilD:
imagenes.

& Nota: En funcién de la aplicacion, «los Study Name:
campos obligatorios» pueden ser
modificados o eliminados. Péngase en
contacto con el servicio de asistencia
técnica de Hologic para obtener mas
informacion.

Study ID:

Para regresar a la pagina de introduccién de
datos de los pacientes, seleccione Accept
(Aceptar) para continuar o Start a New Patient
or Procedure (Iniciar un paciente o procedimiento nuevo).

Start a New Patient or Procedure

Continuar con el paciente actual

Haga clic en el boton Continue with Current Patient (Continuar con el paciente actual) para
continuar con el procedimiento del paciente actual. Se abrira «Image Information Editor»
(Editor de la informacién de las imagenes). Véase la Figura 5.3.3. Siga el procedimiento y las
notas anteriores.

Introduccién manual

Haga clic en el boton Manual Entry (Introduccion manual) para introducir manualmente un
nuevo procedimiento. Se abrira el editor de la informacién sobre la obtencion de imagenes.
Véase la Figura 5.3.3. Siga el procedimiento y las notas anteriores.

5.3.1 Cont.

Figura 5.3.3
Editor de la informacién sobre la
obtencién de imagenes

5.3.2
Continuar con el
paciente actual

5.3.3
Introduccién
manual
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Faxitron® Path SECCION

Software
Sistema de radiografia de muestras VISION
Seleccionar en la base de datos 5.3.4

Seleccionar en la

Si selecciona el boton Select from Database (Seleccionar en la base de datos), aparecera la base de datos

siguiente pagina. Véase la Figura 5.3.4 a continuacion.

Patient D

Search Parameters: 00004 0320-5906 HOUSTON CARLA 2018/04/17 17:35... 1732/04/31 F Figura 5,3.4

atient 10 00t e o isapzes P Seleccion de pacientes en las

. 00002 AvIS672 GARCIA MARIA 1678/03/04 F entradas de la base de datos
0c003 Av35673 SMITH MARY 1678/03/04 F

Fist Nare local

Middle Name
Time Modified

Date of Birth

& Nota: Todos los datos de los
pacientes son ficticios.

Cualquier parecido con personas
reales es pura coincidencia.

I é‘

El usuario selecciona a un paciente en la tabla situada en el lado derecho de la paginay,
a continuacion, hace clic en el boton Accept (Aceptar), que abre el editor de la informacion

sobre las imagenes. (& Nota: Para abrir el editor de informacién sobre las imagenes, el
usuario también puede hacer doble clic en la entrada de la tabla). A continuacion, siga el
procedimiento y las notas de la pagina 5.7.

& Nota: Para ver la informacién oculta de los pacientes, utilice la barra de desplazamiento
situada en la parte inferior de la pantalla.

Vision permite al usuario reducir la lista de pacientes introduciendo informacion especifica en
la ventana «Search Parameters» (Parametros de busqueda) situada en el lado izquierdo de
la pagina. Solamente se mostraran aquellos pacientes que coincidan con todos los
parametros de busqueda.
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Faxitron® Path SECCION

Software
Sistema de radiografia de muestras VISION
Si el usuario desea cambiar o ver la informacion después de haberla introducido 5.3.5

Icono de datos del

(Datos del paciente) situado en la esquina superior izquierda. Véase la )
paciente

pero antes de haber tomado una imagen, podréa pulsar en el icono Patient Data %
Figura 5.3.5.

Figura 5.3.5

Se abrira la ventana de edicion de la informacion sobre el paciente o sobre la obtencién de  Datos del paciente
imagenes. Esta ventana de edicion se rellenara con toda la informacién que se haya introducido

o seleccionado previamente. Véase la Figura 5.3.6. /A% Nota: La ventana de edicién incluira
ahora el botén Cancel (Cancelar).
Figura 5.3.6

El i dra bi Aadir |
usuario podra cambiar o afadir la Dilogo de Datos del paciente

informacién que desee y luego hacer clic en:

« el boton Accept (Aceptar) para guardar los  |[RMEEREEE S sane | §Doe |

cambios y continuar con la obtencion de Patient ID: o
imagenes;

JD4567

Accession #: LN 918273

¢ el boton Cancel (Cancelar) para cancelar los !
cambios y continuar con la obtencion de |G 1920/03/20
imagenes. El software volvera a la Sex:
informacion original sobre el paciente que se
haya introducido, o

¢ el botdon Start a New Patient or Procedure PR
(Iniciar un paglente o] prqcedlmlento nuevo), e
que devolvera al usuario a la pantalla de
introduccion de datos del paciente. Véase la Fosition View:
Figura 5.3.1.

*
-
«w

Body Part:
Refer. Physician:
Technician:

Technician ID:

Study Name:

Study ID:

i)
Y]
a
0
o

Start a New Patient or Procedure

Una vez que el usuario haga clic en el botén Accept (Aceptar), el sistema estara listo para
obtener imagenes o radiografias.

Las radiografias se inician presionando el boton verde Start (Comenzar) en la parte frontal del
armario Faxitron Path o haciendo clic en el botén Start X-Ray (Comenzar radiografia) situado
en la esquina inferior derecha de la pantalla. Véase la seccién 4.2.0, Obtencién de imagenes.
El sistema tomara una breve radiografia «de muestra», o una toma previa (que se explica en
la Seccion 5.4.4), seguida de una exposicion mas prolongada para obtener la imagen. El
software procesara la imagen antes de que se muestre en la pantalla del monitor. Una vez se
muestre la imagen, se activaran los botones situados en los lados izquierdo y derecho de la
pantalla, tratados en toda esta seccion.
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Faxitron® Path

SECCION

Software
Sistema de radiografia de muestras VISION
5.3.5 Cont.
patens ame:  FESTS D TN
Patlom0: Figura 5.3.7

Después de obtener una imagen, el usuario podra
ver, pero no editar, la informaciéon del paciente
haciendo clic en el icono Patient Data (Datos del
paciente) que se muestra en la Figura 5.3.5. Esto
mostrard un cuadro de dialogo modificado Patient
Information (Informacion sobre el paciente), como se
muestra en la Figura 5.3.7. Dicho cuadro incluye dos
botones: Close Dialog (Cerrar dialogo) o Start a
New Patient or Procedure (Iniciar un nuevo
paciente o procedimiento).

Una vez tomada la imagen, se podran ver las propiedades de la imagen actual
pulsando el icono (i) situado en la esquina superior derecha. Véase la Figura 5.3.8.
Aparecera el cuadro de didlogo Image Properties (Propiedades de la imagen) en la
esquina superior derecha de la imagen. El cuadro es semitransparente para

Accession #:

Date of Birth:

Sex:

Frocedure Name:

Laterality:

Position View:

Body Part:

Refer. Physician:
Technician:

Techniclian 10:

Study Name:

Study 1D:

Close Dialog

<

*

918273

1920/03/20

Start a New Patient or Procedure

permitirle a uno ver lo que hay por debajo del cuadro. Véase la Figura 5.3.9.

1.000% 2017/08/14 16:12:18 Monday

28.0 KV, 1.00 mA, !

120170814161218.dcm

C:'\Bioptics\Data\

Faxitron Bioptics

Diélogo de informacién sobre el
paciente tras obtener las
imagenes

Figura 5.3.8
Icono de propiedades de la
imagen

Figura 5.3.9
Diélogo de propiedades de la
imagen (solo lectura)
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Faxitron® Path SECCION

Software
Sistema de radiografia de muestras VISION

El software Vision proporciona varias herramientas y menus para controlar varios atributos o 54.0
parametros de las imagenes, la obtencién de rayos X, las vistas de imagen, las herramientas Barra de
de imagen y los ajustes o accesos de DICOM. Las herramientas mas utilizadas estan situadas A
en una barra de herramientas. La barra de herramientas y los menus se describen con mas herramientas
detalle en las proximas paginas. y menus

Con un solo clic, el software Vision permite acceder a una serie de herramientas o funciones de 541

uso comun con una barra de herramientas vertical ubicada en el lado izquierdo de la pantalla. En Barra de

las paginas siguientes se ofrecen descripciones mas detalladas. Véase la Figura 5.4.1. A
herramientas

lateral

Ver o modificar la informacion sobre A NOTAS:
el paciente ’
(Véase la seccion 6.3.5 y Figura 6.3.5)

Figura 5.4.1
Barra de herramientas lateral
Las siguientes herramientas estan
siempre activas en la pagina de
obtencién de imagenes:
o Ver o modificar la informacién
sobre el paciente
e Control de la exposicién
e Volver al menu principal
¢ Apagado del sistema

Icono de mejora de la imagen

Herramienta Nivel de la ventana
y contraste

Las siguientes herramientas se

Herramienta Zoom digital desactivaran después de introducir
los datos del paciente y solamente se
activaran tras obtener una radiografia:
e Mejorar la imagen

Herramientas de anotacion « Nivel y contraste de la ventana
e Zoom digital
¢ Anotacion

PACS Save (Guardar en SACI) Las herramientas PACS Save

(Guardar en SACI) y PACS Print
(Impresion en SACI) solamente se
activaran después de realizar una

. L radiografia y cuando el sistema esté
PACS Print (Impresiéon en SACI) conectado a una red SACI.

Control de la exposiciéon (Panel de control del dispositivo)

Volver al menu principal

Apagado del sistema

HOLOGIC
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Faxitron® Path

SECCION

Software
Sistema de radiografia de muestras VISION
Mejorar imagen 5.4.1 Cont.
El botdn mostrado en la Figura 5.4.2 procesara la imagen en la pantalla para destacar en ella
los detalles mas pequefios, como las microcalcificaciones y las pequefias masas. Figura 5.4.2

/4(

En la obtencion de imagenes avanzadas, el algoritmo comunmente denominado «ecualizacion
periférica» o «ecualizacion del espesor» se aplica a toda la imagen. Ademas de este algoritmo,
Hologic emplea un segundo algoritmo desarrollado internamente y llamado «énfasis de las
calcificaciones». Este algoritmo secundario fue creado para resaltar pequefios detalles de la
imagen y hacerlos mucho mas faciles de ver y analizar.

Dado que las imagenes de los pacientes constituyen una categoria mas general en cuanto a
las posibles geometrias y la variedad de espesores, puede que haya geometrias de las
muestras que representen un reto, y el usuario debera utilizar esta herramienta con cuidado.

El sistema estara inactivo (en espera) durante el proceso. Una vez finalizado, el botén
permanecera pulsado o activo. El usuario podra deshacer el proceso pulsando de nuevo el
boton.

Icono de mejora de la imagen
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Faxitron® Path SECCION

Software
Sistema de radiografia de muestras VISION
Ajuste de la inversion, el nivel de la ventana y el contraste 5.4.1 Cont.
El boton, mostrado en la Figura 5.4.3, abrira la herramienta de ajuste Window Level and
Contrast (Nivel de la ventana y contraste). Esta herramienta permite al usuario ajustar el nivel
de la ventana y el contraste de la imagen. El usuario también podra restaurar el contraste
original pulsando el botén Original Contrast (Contraste original) o invertir la imagen pulsando
el boton Invert (Invertir). La inversion cambia el esquema croméatico de ser predominantemente
negro a ser predominantemente blanco, y viceversa. Véase la Figura 5.4.4 siguiente.
Figura 5.4.3
Icono y controles de la
herramienta Nivel de la ventana y
contraste
El usuario también podra ajustar el contraste
deseado de la imagen haciendo clic en la barra
deslizante y moviéndola hacia arriba y hacia abajo o
haciendo clic en las flechas que correspondan de la E3
barra para mover los limites inferior o superior del
nivel de la ventana. Véase la Figura 5.4.3
(informalmente, esto también se denomina
«Equilibrado de la ventana»).
Original Contrast
A continuacion se muestra el ejemplo de una
Ve Figura 5.4.4

Ejemplo de inversién con la
herramienta Ajuste del contraste
y nivel de la ventana
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Faxitron® Path

Sistema de radiografia de muestras

SECC

ION

Software

VISION

Ajuste del zoom dinamico

El icono de la herramienta de zoom, Figura 5.4.5, abrira la herramienta de ajuste del zoom.
Después de abrir esta herramienta, el usuario podra utilizar la barra deslizante para ajustar el
nivel del zoom o hacer clic en los botones Fit to Specimen (Ajustar al espécimen), Fit to
Screen (Ajustar a la pantalla) o Zoom 1.0x (resolucion completa). Véase la Figura 5.4.6. Para
navegar por toda la imagen, cuando esta haya sido ampliada, sera necesario realizar una
panoramica. Aparecera un cuadro de dialogo en miniatura en la esquina superior izquierda de
la pantalla. Véase la Figura 5.4.7 a continuacion. Para mover la imagen en la pantalla principal,
haga clic y mantenga presionado el botén izquierdo sobre la imagen, y mueva el raton.

Tenga en cuenta que, tradicionalmente, esta funcion también se denomina «Vista panoramica»
o «Pan and Scany.

f
3.00x
1.00x
0.10x

Para asegurarse de que el espécimen esté a la vista, el botén 0.44
Fit to Specimen (Ajustar al espécimen) intentara detectar y | —
ampliar el espécimen. Si no se detecta un espécimen, este se
ajustara por defecto al modo anterior (ya sea «Fit to Screen»
[Ajustar a la pantalla] o0 «Zoom 1.0x»). |
Fit to Screen (Ajustar a la pantalla) ajustara la imagen a la

|
pantalla.

Tradicionalmente, Zoom 1.0x se denomina «resolucion
completa», ya que lleva la imagen a una vista 1-1 con la
resolucion del monitor.

5.4.1 Cont.

Figura 5.4.5

Icono de la herramienta Zoom

Figura 5.4.6
Herramienta
de zoom

Figura 5.4.7

de ajuste del nivel

Ejemplo de vista panordmica

(izquierda)
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Faxitron® Path SECCION

Software
Sistema de radiografia de muestras VISION
Anotacion 5.4.1 Cont.
El botén mostrado en la Figura 5.4.8 abrira las herramientas de anotacion. Estas Figura 5.4.8

herramientas y sus numerosas funciones se tratan con mas detalle en la seccion 5.8.0. Jcono de Anotaciones

Almacenar en SACI

Figura 5.4.9

El botén mostrado en la Figura 5.4.9 solamente funcionara cuando el sistema esté
Icono de Guardar en SACI

instalado en un centro médico con una red SACI. Para guardar sus archivos
localmente, consulte la seccion 5.7.0.

O

Impresién en SACI

El botén mostrado en la Figura 5.4.10 solamente funcionara cuando el sistema esté Figura 5.4.10 iy
. e . e Icono de Impresion en
instalado en un centro médico con una red SACI. Para efectuar la impresion local, % SACI
consulte la seccion 5.7.0.
Panel de control del dispositivo
El boton mostrado en la Figura 5.4.11 abrira el panel de control del dispositivo, lo Figura 5.4.11

que ofrecera al usuario del dispositivo la oportunidad de controlar el sistema de Icono de Volver al procedimiento
rayos X mediante el software. El usuario podra seleccionar faciimente el modo de
exposicion, el ajuste de kV del tubo de rayos X, el tiempo de exposicion y el numero
de imagenes que deberan obtenerse para el promediado de las imagenes (si lo

desea), asi como iniciar la exposicién a los rayos X.

Figura 5.4.12
& Nota: El estado o la disponibilidad de los Panel de control del dispositivo
ajustes de la exposicién se indica mediante las
flechas arriba y abajo adyacentes al ajuste. Las @ Full Auto O Auto kV
flechas seran blancas para los ajustes activos y O Auto Time O Full Manual

celestes para los inactivos. Los ajustes de la
exposicion que estén activos dependeran del
modo de exposicién seleccionado.

La Figura 5.4.12 de la derecha muestra que se ha
seleccionado el modo Full Auto (Totalmente
automatico) y que los promedios de kV, tiempo e 26
imagen estan todos activos. El usuario podra

ajustar cada una de estas configuraciones.

Tenga en cuenta que, en el sistema Faxitron Path, bl
la configuracion de mA no se puede ajustar

utilizando el software. La configuracién de mA se O 40

mostrara como inactiva. .

Cuando termine, haga clic en el botén Request A
X-Rays (Solicitar rayos X) para adquirir una
imagen o en el boton Set (Ajustar) para guardar la Image Averages AV
configuracion y cerrar el panel de control del
dispositivo.

Request X-Rays

Si se hace clic en el botén Cancel (Cancelar), el
panel de control del dispositivo se cerrara sin
guardar ninguno de los cambios. < Cancel
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Faxitron® Path

SECCION

Software
Sistema de radiografia de muestras VISION
Volver al procedimiento 5.4.1 Cont.
El botén mostrado en la Figura 5.4.13 cierra el modo de obtencion de imagenes y .
regresa a la pantalla del Home Menu (Men( de inicio). Figura 5.4.13

O

Apagado

El boton mostrado en la Figura 5.4.14 cierra el software y apaga el sistema.

Notas de dialogo adicionales

Cuando se abre un didlogo, este se «acopla» a la izquierda de la pantalla. Si un usuario desea
desacoplar el cuadro de dialogo, podra hacer clic en el icono de «anclaje» superior derecho
para desacoplar el cuadro de diélogo y poder arrastrarlo libremente. El «anclaje» se convertira
luego en un icono «X», que permitira el cierre rapido.

Los usuarios también pueden navegar rapidamente entre los distintos dialogos haciendo clic
en el menu de la izquierda. Al hacerlo, el menu de la izquierda se cerrara rapidamente y abrira
los cuadros de didlogo correspondientes, segun sea necesario.

Barra de menu superior

El software permite acceder a los menus «View» (Ver), « Tools» (Herramientas), «Image Tools»
(Herramientas de imagen), «DICOM Utilities» (Utilidades de DICOM) y «Help» (Ayuda)
mediante una barra de menu superior. Véase la Figura 5.4.15. La barra de menu superior esta
oculta de forma predeterminada y se muestra haciendo clic en el botén de flecha ubicado en
la esquina superior derecha de la pantalla. Véase la Figura 5.4.16. El botén de flecha sera
blanco o negro, dependiendo de la pagina del software o el fondo de pantalla. Cada elemento
del menu se tratara en detalle en las paginas siguientes.

File Edit View Tools Image Tools DICOM Utilities Help

~

El menu «View» (Ver) se encuentra en el menu principal superior y contiene los elementos del
submenu mostrados en la Figura 5.4.17 siguiente. Cada elemento del submenu se describira
con mas detalle en las proximas paginas.

& Nota: La flecha apuntara hacia abajo cuando la barra de menu
superior esté oculta, y hacia arriba cuando esta se muestre.

Menu Ver

mTools Image Tocls  DICOM Utilities  Help

Zoom Mode 3 MNORMAL (FULL RES.)
Image Averages ADJUST ZOOM
Image Perspective FIT TO SAMPLE

Grid Options v | FTALL

User Window Levels FIT WIDTH

Default Window Level FIT HEIGHT

Default Aspect for Raw Files
Enhanced Image
Sample Viewer

Magnifier Size

* ¥ ¥ ¥ v v v v v v

Review Layout

Icono de regreso al menu de
inicio

Figura 5.4.14
Icono de apagado del sistema

5.4.2
Barra de menu
superior

Figura 5.4.15
Barra de ment superior

Figura 5.4.16

Botones de la barra de ment
superior

5.4.3
Menu Ver

Figura 5.4.17
Mend Ver
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Faxitron® Path SECCION

Software
Sistema de radiografia de muestras VISION
Modo zoom 5.4.3 Cont.
Normal

Muestra la imagen obtenida en su formato original. La imagen de los sistemas Faxitron Path
supera el area de visualizacidn de los monitores. En la esquina superior izquierda de la imagen
se mostrara un cuadro de dialogo en miniatura que permitira al usuario «panoramizar» la
imagen. Consulte Ajuste del zoom dindmico en la Seccién 5.4.1.

Adjust Zoom (Ajustar el zoom)

Esta opcion esta desactivada y no esta disponible en este momento.

Fit to Sample (Ajustar al espécimen)

Esta opcién adapta la imagen obtenida para que se ajuste mejor a la muestra de especimenes
dentro del area de visualizacion del monitor.

Fit All (Ajustar todos)

Esta opcion muestra toda la imagen obtenida, independientemente de cual sea su formato
original. La opcién Full Resolution (Resolucion completa) no funciona en este modo de vista.

Fit Width (Ajustar anchura)

Esta opcion muestra la imagen obtenida a lo largo del ancho disponible de toda el area de
visualizacion.

Ajustar altura (Ajustar altura)

Esta opcién muestra la imagen obtenida a lo largo de la altura disponible de toda el area de
visualizacion.

Image Averages (Promedios entre las imagenes)

Esta opcion permite al usuario ajustar el nimero de promedios entre las imagenes que se
tomaran por cada exposicion. Las opciones disponibles son las tomas 1x, 2x, 4x u 8x. El ajuste
predeterminado es la toma 1x. Si el usuario selecciona 2, 4 u 8 tomas, el software obtendra el
numero de imagenes seleccionadas una detras de otra pulsando el botén Start (Comenzar)
una sola vez y promediara esas imagenes en una sola imagen.

Image Perspective (Perspectiva de la imagen)

Esta opcién permite al usuario rotar la imagen visualizada a una orientacion de 0, 90, 180 y
270 grados.
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Grid Options (Opciones de cuadricula) 5.4.3 Cont.
Cuando se muestra una imagen, ya sea como una imagen obtenida o una imagen recuperada
de la base de datos, el usuario podra activar una cuadricula. También permite al usuario
establecer el espaciado (anchura) de la cuadricula. Véase el ejemplo siguiente.
: Figura 5.4.18

User Window Levels (Niveles de la ventana de usuario)

Esto permite al usuario definir hasta tres (3) niveles de la ventana (WL) prefijados y
establecidos por el usuario. En primer lugar, seleccione el boton Window Level (Nivel de la
ventana). Ajuste el WL al nivel deseado. En las herramientas «View» (Ver), seleccione «User
Window Levels» (Niveles de ventana de usuario). Seleccione «Record Current WL» (Registrar
WL actual) como USUARIO WL n.° 1, n.° 2 o n.° 3. EI WL ajustado se guardara segun la opcion
seleccionada previamente.

Default Window Level (Nivel predeterminado de la ventana)

El usuario tiene dos opciones de «Default Window Levels» (Niveles predeterminados de la
ventana) (WL): «Optimize for whole area» (Optimizar para toda el area), que ajusta el WL para
toda la imagen, u «Optimize for sample» (Optimizar para el espécimen), que ajusta el WL
solamente para el area del espécimen. Ademas, existe la opcion «Set Default Window Level»
(Establecer el nivel predeterminado de la ventana), que se utiliza también para todas las
imagenes obtenidas que se encuentran aqui. Esta establecera el nivel predeterminado de la
ventana en funcion de las estadisticas de la imagen, y debera hacerse por separado para las
imagenes no mejoradas y las mejoradas.

Default Aspect of Raw Files (Aspecto predeterminado de los
archivos sin procesar)

Esta herramienta se encuentra bajo el menu VIEW (Ver). Ayuda a importar y abrir archivos de
imagenes previamente guardados con atributos de archivo desconocidos o datos de imagenes
binarios que no tienen ninguna informacion de encabezado. Dado que el tamafio exacto del
conjunto del generador de imagenes no esta disponible en el encabezado del archivo de datos
de imagen, se usaran las dimensiones del generador de imagenes mas adecuadas para
importar o abrir dichas imagenes en funcién de que el ancho sea mayor o menor que la altura
(informacion de aspecto predeterminada).

Enhance Image (same as the Enhance Image button) (Mejorar la
imagen [igual que el boton Mejorar la imagen])

Procesa la imagen actual del paciente y mejora la visualizacion del tejido situado cerca de la
periferia de la muestra.

Visualizacion de la cuadricula de

la muestra

HOLOGIC

MANUAL DE USUARIO DE FAXITRON PATH | HOLOGIC | REVISION 001

5-18



Faxitron® Path

Sistema de radiografia de muestras

SECCION

Software
VISION

Sample Viewer (Visor de muestras)

En el caso de que el sistema tenga una camara web, esta conmutara el visor de la camara web
del sistema para permitir la orientacién y alineacién de los especimenes.

Review Layout (Disposicion de la revision)

Ayuda al usuario a configurar multiples paneles de imagen en Review (Database) Mode (Modo
de revision [de la base de datos]) del programa. Las opciones de disposicion disponibles son:
«(1 X 1) Single» (Simple), «(2 X 1) Double H» (Doble H), «(1 X 2) Double V» (Doble V), «(1 +
(2 X 1) Triple» y «(2 X 2) Quadruple» (Cuadruple). Durante la operacion con paneles muiltiples, el
usuario puede hacer clic una vez en el panel o la imagen deseada para realizar la seleccion
actual; el panel seleccionado actual tendra un borde rectangular verde alrededor. Las imagenes
incluidas en la vista de lista de la base de datos o vista de miniaturas de la base de datos se
abriran en el panel seleccionado actual cuando se haga doble clic sobre ellas. El usuario también
podra abrir las imagenes en los paneles deseados directamente desde el menu contextual de las
vistas de la base de datos mencionada. Después de activar el menu contextual, el usuario podra
seleccionar en los paneles listados bajo OPEN TO— (ABRIR HACIA), que proporcionara los
paneles disponibles para abrir la imagen (izquierda, derecha, arriba, abajo, etc.).

Menu Tools (Herramientas)

El menu «Tools» (Herramientas) esta ubicado en la barra de menu superior, situada en la
esquina superior izquierda de la pantalla principal.
ImageToDIs DICOM Utilities Help

Preferences
Service Mode
Service Tools

Save Reference Files

Advanced Tools 3 AUTO SAVE ON/OFF o
PROPERTIES EDGE SUPPRESSION b
TILE SUPPRESSION »

EDIT  CurrentImage Record
DELETE Current Image Record
ADD  Current Image Record

K-RAY Calibration/Exposure Setup
PRESHOT AEC Exposure Setup

IMAGE ENHANCEMENT Setup

Legin Utility

Save/Store current image 2 Cylic Automated Acquisitions

Print current image » OTHER ADVANCED User Tools [

CAPTURE Screen Shot JPG/BMP

Preferences (Preferencias)

El menu «Preferences» (Preferencias) abre una utilidad de gestion de la configuracién que
permite cambiar varias opciones o parametros.

& Nota: La herramienta «Preferences» (Preferencias) esta protegida mediante contrasefa y
solamente puede acceder a ella un representante autorizado del servicio técnico de Hologic.

/% Nota: Cambiar los parametros de configuracion sin los conocimientos ni la autorizacion
pertinentes podra causar la pérdida de calidad de las imagenes, dafios en el sistema y
funcionamiento incorrecto del sistema.

Modo Service (Modo de mantenimiento)
El «Service Mode» (Modo de mantenimiento) esta protegido mediante contrasefia y lo activan
técnicos autorizados de Hologic para resolver problemas.
Service Tools (Herramientas de mantenimiento)

«Service Tools» (Herramientas de mantenimiento) suelen aparecer sombreadas en gris.
Solamente se enciende cuando el sistema esta en «Service Mode» (Modo de mantenimiento).

5.4.3 Cont.

544
Menu Herramientas

Figura 5.4.19
Menu Herramientas
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Save Reference Files (Guardar archivos de referencia) 5.4.4 Cont.

La opcién «Save Reference Files» (Guardar archivos de referencia) suele aparecer
sombreada en gris. Solamente se enciende cuando el sistema esta en «Service Mode»
(Modo de mantenimiento).

Opcién Advanced Tools (Herramientas avanzadas)

Las «Advanced Tools» (Herramientas avanzadas) ofrecen varias opciones para configurar
aspectos del software tales como el postprocesamiento y las opciones de configuracion.

Auto Save On/Off (Guardar el encendido y apagado automatico)

Cuando «Auto save» (Guardar automdticamente) esta «activado», todas las imagenes
obtenidas posteriormente se guardaran en la base de datos. Los archivos se escribiran en un
directorio de datos definido en el archivo de configuracion.

X-Ray Calibration/Exposure Set-up (Calibracion de los rayos
X/Configuracioén de la exposicion)

Se encuentran en Advanced Tools (Herramientas avanzadas). «X-Ray Calibration/Exposure
Setup» (Calibracion de los rayos X/Configuracion de la exposicion) ayuda al usuario a
determinar el tiempo de exposicion adecuado para un determinado ajuste de kV que obtenga
la mejor calidad de las imagenes. Consulte en la seccion 5.2.0 y la Figura 5.2.1 una descripcion
mas detallada.

Configuracion del CAE de la exposicién de una toma previa

El sistema Faxitron Path utiliza el control automatico de la exposicién (CAE) para proporcionar
la mejor calidad posible de las imagenes pulsando el boton Start X-Ray (Comenzar radiografia)
una sola vez. El software utilizara una exposicidon de una Preshot (Toma previa) para calcular
los ajustes optimos de la exposicion en kV y tiempo. La foma previa es una exposicion breve a
los rayos X, normalmente de 2 a 3 segundos. El software analizara los resultados para
determinar los kV y el tiempo necesarios para producir la mejor calidad de las imagenes. La
exposicion al CAE de una toma previa se configura en fabrica y se activa de forma
predeterminada.

«Preshot AEC Exposure Setup» (Configuracion del CAE de la exposicién de una toma previa)
permite al usuario ajustar el sistema a determinados requisitos de obtencién de imagenes o
para compensar el envejecimiento del sistema.

Para acceder al cuadro de didlogo «Preshot AEC Exposure Setup» (Configuracién del CAE de
la exposicion de una toma previa), vaya a la barra de menu superior, seleccione «Tools»
(Herramientas), «Advanced Tools» (Herramientas avanzadas) y, a continuacion, «<PRESHOT
AEC Exposure Setup» (Configuracion del CAE de la exposicion de una toma previa). Véase la
Figura 5.4.19.
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Introduzca los valores de PRESHOT
AEC (CAE DE LA TOMA PREVIA)
en la ventana que se muestra a la
derecha.

Para el ajuste de las tomas previas,
los ajustes mostrados reflejan un
tiempo de exposicion de 26 kV y
3 segundos con una intensidad
objetivo de 10.000 UAD. Los
usuarios pueden introducir la
seleccion de parametros de la toma

previa seleccionando solamente
DYNAMIC METHOD (METODO
DINAMICO) en la seccion

ANALYSIS METHOD (METODO DE
ANALISIS). La seleccion de STATIC
METHOD (METODO ESTATICO)
utilizara parametros predefinidos por
Faxitron. Ademas, el usuario tendra
la opcién de seleccionar los ajustes
de kV y tiempo de exposicion en la
seccion EXPOSURE  TUNING
METHOD (METODO DE AJUSTE
DE LA EXPOSICION).

Para obtener unas imagenes mas
precisas, el usuario podra introducir
el grosor de SOFT TISSUE (Sample)

(TEJIDO BLANDO [Muestra]) y

PRESHOT - AEC ON/OFF

PRESHOT &NALYSIS METHOD

DYNAMIC METHOD
& |hcquire Preshat Image Before Every Image, Analyze and
Tune Settings)

¥ TURN OM PRESHOT - AEC

~

DNamIC PRESHOT PREFEREMCES
PRESHOT k¥ DESIRED [k¥] 260
2.00

PRESHOT TIME DESIRED [g]

PRESHOT COMEINATION ‘[1]NEINE,D\‘SEAHD PRESHOT, SHOW AEC SHOT ALONE j

230
E.72
oo =

ExPOSURE TUNING METHOD
@ AUTORY /MUTOTIME € AUTO KV / FIXED TIME

7.30 45.0

THICKNESS/BEAM HARDENING A0VEREURN

[¢ AUTO DETECT SAMPLE THICKNESS
FROM PRESHOT/PRELOADED IMAGE

7 FIMED k¥ /AUTO TIME

I ENABLE OWERBURM PROTECTION

" Preshot and AEC shot are
assumed to have similar
sample+tray thicknesses

ENTER SOFT TISSUE EQUIVALENT -
SAMPLE +TRAY THICKNESS 0] 0.00"=0.00 em

TARGET INTENSITY

ENTER DESIRED MEAN
INTENSITY UNDER SAMPLE  [ADU]

* GENERAL RECOMMENDATION: Use
E0-30% of Mean Flat Field Value For
S atistactony Results

’W
s
o

TARGET INTENSITY (INTENSIDAD DEL OBJETIVO) en las UAD. Nota: Los valores de la
imagen superior son solo un ejemplo. Es necesario determinar los valores correctos.

& Nota: Los valores en la imagen superior son los tipicos para el sistema Faxitron Path.
Debera determinar los valores exactos para su sistema.

Para el modo AUTOMATIC EXPOSURE CONTROL (CONTROL DE LA EXPOSICION
AUTOMATICA), pulse el boton Start (Comenzar) en el software Vision (o en el panel de
control). Para crear una region de interés (ROI) y obtener los parametros de exposicién para la
exposicion optima de la imagen, el software Vision realizara una toma previa (exposicion previa

a una dosis breve y baja) de la muestra.

Login Utility (Utilidad de inicio de sesion)

La Login Utility (Utilidad de inicio de

sesion) que estd en el menu
ADVANCED TOOLS (Herramientas
avanzadas) permite al usuario

configurar y activar la autenticacién con
contrasefia de inicio del software Vision.
En el sistema Faxitron Path, Ila
activacion de esta funcion es opcional.
Si el usuario activa la autenticacion con
contrasefa, se le pedira cada vez que
abra el programa. Si no se introduce la
contrasefia correcta, el programa se
cerrara.

Current Password:

NEW PASSWORD |

RE-ENTER MEW
PASSWORD |

CHANGE
PASSWORD:

AUTHENTICATE
OPTION:

¥ Entorce Lser Authentication on Software Startup

Apply Changes

5.4.4 Cont.

Figura 5.4.20

Cuadro de diglogo Preshot AEC
Setup (Configuracion del CAE de
una toma previa)

Figura 5.4.21

Login Utility (Utilidad de
inicio de sesién). En la
autenticacion del inicio
aparecera esta misma
pantalla.
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Properties (Propiedades) 5.4.4 Cont.
«Properties» (Propiedades) oculta o muestra el cuadro de informacion de la imagen. Véase la
Figura 5.3.9.

Edit Current Image Record (Editar el registro de imagen actual)

Actualmente no se utiliza.

Delete Current Image Record (Eliminar registro de imagen actual)
Elimina la imagen actual del directorio de archivos, tal y como se especifica en el archivo de
configuracion.

Add Current Image Record (Agregar registro de la imagen actual)
Afade la imagen actual al directorio de archivos, tal y como se especifica en el archivo de

configuracion.

Capture Screen Shot JPG/BMP (Realizar captura de pantalla en
JPG/BMP)

Seleccionando esta opcion del menu, el usuario puede realizar una captura de pantalla de la
ventana activa mostrada. El usuario puede especificar un nombre de archivo y elegir entre
JPG y BMP como formato de archivo guardado.

Save/Store Current Image (Guardar o almacenar la imagen actual)

El usuario puede «navegar» hasta el directorio o la carpeta de archivos en la que desee
guardar la imagen. Debera asignarse un nombre de fichero en el campo proporcionado.
Seleccione un formato de tipo de archivo en el que guardar la imagen. Se proporcionan
numerosos tipos de archivo. Para guardar el archivo en formato DICOM, consulte la seccién
«DICOM Functionality» (Funcionalidad DICOM).

Print Current Image (Imprimir imagen actual)

Imprime la imagen actual en la impresora de WINDOWS.

5.4.5
Image Tools (Herramientas de imagen) Herramientas de

Para editar la imagen obtenida o recuperada, estan disponibles las siguientes funciones imagen
haciendo clic en el menu «Image Tools» (Herramientas de imagen). Véase la Figura 5.4.22.

Con un solo clic sobre la opcién deseada, se podra acceder -

a o activar las opciones del subment. Image Tools e

o Figura 5.4.22
Original Contrast Menti Herramientas de imagen

Invert

Magnifier
Enhance

ROI Contrast

ROI Window Level
Ruler

ROI Statistics

ROI Histogram
ROI Profile

Line Profile
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Original Contrast (Contraste original)

«Original Contrast» (Contraste original) restaura los niveles de contraste de la imagen. Esto
sirve para el mismo proposito que el botdon Original Contrast (Contraste original) en la
herramienta Window Level and Contrast (Nivel de la ventana y contraste). Véanse la
seccion 5.4.1y la Figura 5.4.3.

Invert (Invertir)

«Invert» (Invertir) hace que la imagen visualizada se invierta o revierta. Al invertir una imagen,
se invierte su transparencia: lo que es negro se convierte en blanco y lo que es blanco se
convierte en negro. A los grises se les asigna su transparencia espejo. Para desactivar la
funcién, haga clic de nuevo en «Invert» (Invertir). Realiza la misma funcién que el boton Invert
(Invertir). Consulte la seccion 5.4.1 y las Figuras 5.4.3y 5.4.4.

Magnify (Ampliar)

«Magnify» (Ampliar) permite al usuario ampliar un area de interés. Para utilizar la funcién Magnify
(Ampliar), situe el cursor del ratén sobre el area que desee ampliar y haga clic con el botén
izquierdo del ratén. Se ampliara el area de interés. Para desactivar la funcién, haga clic de nuevo
en «Magnify» (Ampliar). Consulte la Figura 5.4.23. El usuario podra ajustar el tamafio del area de
interés ampliada. Consulte el submenu «Magnifier Size» (Tamafo de la lupa) en la seccion 5.4.3.

Edge Enhance (Realce de los bordes)

«Edge Enhance» (Realce de los bordes) definira con mayor nitidez los bordes de las regiones
utilizando una diferencia de contraste. Puede que el realce de los bordes amplifique el ruido en
las imagenes en general. Seleccionando de nuevo la opcion del menu, se desactivara el realce
de bordes. Si hace clic en «Original Contrast» (Contraste original), la imagen volvera a su
estado original. Tenga en cuenta que esta es una funcion diferente a la funcién Enhance Image
(Mejorar la imagen) de la seccion 5.4.1y 5.4.3.

ROI Contrast (Contraste de la ROI)

«ROI Contrast» (Contraste de la ROIl) optimizara los niveles de contraste del interior de una
region de interés (ROI) definida por el usuario. Después de seleccionar «RO! Contrast»
(Contraste de la ROI), haga clic y mantenga pulsado el botén izquierdo del ratén en el punto
inicial de la ROl deseada, arrastre el raton y suelte el boton del ratén en el punto final de la ROI
deseada. El contraste se ajustara automaticamente a los mejores niveles para esa ROI (para
mas informacion sobre la ROI, consulte la seccion Definiciones).

ROI Window Level (Nivel de ventana de la ROI)

La funcién «ROI Window Level» (Nivel de ventana de la ROI) no esta disponible en la versién
actual del software Vision.

5.4.5 Cont.

Figura 5.4.23
Ampliar
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Ruler (Regla) 5.4.5 Cont.

«Ruler» (Regla) permite al usuario medir la distancia entre dos puntos de la imagen visualizada.
Las medidas de longitud se expresan en milimetros (mm). Después de seleccionar «Ruler»
(Regla), haga clic y mantenga pulsado el botén izquierdo del ratén y, empezando por el punto
inicial de la medicion, arrastre el raton y suelte el botdn del ratén en el punto final de la medicion.
En la imagen, la regla tiene el aspecto de una linea roja.

Figura 5.4.24

La medicion (en mm) se muestra al
Regla

final de la regla. Hasta que el
usuario seleccione otra
herramienta de imagen o hasta
que se realice otra accion, la regla
permanecera activa. Véase Ia
Figura 5.4.24 a la derecha. Para
desactivar la funcién, haga clic de
nuevo en «Ruler» (Regla).

Sugerencia: Para obtener una
linea perfectamente recta o una
linea en un angulo perfecto de 45
grados, mantenga pulsada la tecla
SHIFT (del teclado) mientras
mantiene pulsado el botdn
izquierdo del raton y arrastre.

ROI Statistics (Estadisticas de la ROI)

«ROI Statistics» (Estadisticas de la ROI) mostrara un cuadro de didlogo que contiene estadisticas
de la imagen. Haga clic y mantenga presionado el botén izquierdo del ratén sobre la region de
interés (ROI) de la imagen principal, arrastre el cursor para hacer la seleccién alrededor del area
y luego suelte el boton del ratdn. La informacion estadistica de la region seleccionada se mostrara
en el lado izquierdo del cuadro de dialogo y la de toda la imagen, en el lado derecho del recuadro.
Las estadisticas que se muestran son: los puntos inicial y final de la ROI, los valores de intensidad
Minimum (Minimo), Maximum (Maximo) y Mean (Medio) y Standard Deviation (Desviacion
estandar) (STD). Para cerrar el cuadro de informacion Statistics (Estadisticas), simplemente haga
clic en el boton Close (Cerrar). Véase la Figura 5.4.25. Para desactivar la funcién, haga clic de
nuevo en «ROI Statistics» (Estadisticas de la ROI).

Figura 5.4.25
Estadisticas de la ROl

Selected Region Whale Image

[T op Left)=[583.1383) [Top.Left)=(00]
[Battorn,Right)=[1183,2558) [Buottor,Right)=(3072,3833]

Minirnurm: 516 Mirirnurn: 523

M awirnurn: 7537 M awirnurn: 14042
Mean:5620.00 Mean: 606,26
STO: 855.60 STO:4026.28

|
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ROI Histogram (Histograma de la ROI)

«ROI Histogram» (Histograma de la ROI) creara un histograma para una ROI definida por el
usuario. Después de seleccionar la opcién del menu, coloque el cursor del ratén en la imagen
visualizada, mantenga pulsado el botén izquierdo del ratén y arrastrelo para seleccionar la ROI
deseada. Suelte el botén del ratén. Se mostraran histogramas de la ROI seleccionada. Véase
la Figura 5.4.6.

La curva negra es el histograma de la regién seleccionada. La curva azul es el histograma de
toda la imagen. Ambas curvas se normalizan contra el valor maximo de pixeles de la region de
interés seleccionada. Para desactivar la funcion, haga clic de nuevo en «ROI Histogram»
(Histograma de la ROI).

Histogram
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ROI Profile (Perfil de la ROI)

«ROI Profile» (Perfil de la ROI) creara un perfil para una ROI definida por el usuario. Después de
seleccionar la opcidén del menu, coloque el cursor en la imagen visualizada. Para dibujar un
cuadro definido por el usuario alrededor de la ROI deseada, mantenga pulsado el boton izquierdo
del ratén y mueva el cursor por la imagen. Suelte el botén izquierdo del ratdn y aparecera un perfil
que mostrara los valores de cada pixel de la ROI definida. Véase la Figura 5.4.27. Por defecto,
la direccion de la promediacion de la ROl seleccionada es el eje corto. El eje puede desplazarse
hacia adelante y hacia atras seleccionando el botén SWITCH, HOR<->VERT (CAMBIAR
HORIZONTAL<->VERTICAL). Para desactivar la funcion, haga clic de nuevo en «ROI Profile»
(Perfil de la ROI).

Horizontal Region Profile
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5.4.5 Cont.

Figura 5.4.26
Histograma de la ROI

Figura 5.4.27
Perfil de la ROl
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Line Profile (Perfil de la linea)

«Line Profile» (Perfil de la linea) mostrara el perfil de una linea definida por el usuario. Después
de seleccionar «Line Profile» (Perfil de la linea), coloque el cursor en la imagen visualizada.
Para dibujar una linea definida por el usuario, mantenga pulsado el boton izquierdo del ratén y
mueva el cursor por la imagen. Suelte el botén izquierdo del ratén y aparecera un perfil que
mostrard los valores de cada pixel de la linea definida. Véase la Figura 5.4.28. Por defecto, el
primer punto seleccionado es siempre la parte izquierda (mas cercana al origen) del grafico (es
decir, el eje horizontal del grafico puede tener indices de pixeles (i, i) crecientes o decrecientes,
dependiendo de los puntos inicial o final que se hayan seleccionado). Para desactivar la
funcién, haga clic de nuevo en «Line Profile» (Perfil de la linea).

I Line Profile
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5400.00
4700.00
4000.00
3300.00
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Index on the Line From Point (2235.861) To (3362 858)

saveasTa1| ANt | [ cose

Built-ln Window Level (Nivel de ventana incorporado)

El software Vision incluye una funcion de Window Level (Nivel de ventana) «incorporado». Para
seleccionarlo, no hay ningun botén ni elemento del menu. La funcién Window Level (Nivel de
ventana) se activa automaticamente cada vez que se obtiene una imagen o se recupera de la
base de datos para revisarla. Esta funcion permite al usuario ajustar los niveles de contraste y
brillo de la imagen utilizando el ratén o el cursor.

Para ver los niveles de brillo u oscuridad, haga clic y mantenga pulsado el botén izquierdo del
ratén sobre la imagen visualizada y mueva el cursor hacia arriba y hacia abajo, o mueva el
cursor hacia la izquierda o hacia la derecha para subir o bajar el contraste. Mueva el cursor
hasta que la imagen se encuentre en los niveles deseados.

5.4.5 Cont.

Figura 5.4.28
Perfil de la linea
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Presionando el boton, mostrado en la Figura 5.5.1 y ubicado en la parte inferior de la ventana 5.5.0

de obtenciéon de imagenes, aparecera la secuencia de imagenes en miniatura del paciente
actual. Véase la Figura 5.5.2.

N

BROWSER

En texto naranja y a lo largo de la parte superior, la secuencia de miniaturas mostrara la fecha
en la que se realiz6 el procedimiento de cada serie de imagenes individuales.

Se iluminaréa en verde la imagen actual que aparece mostrada en la ventana de obtencion de
imagenes.

Para colocar las imagenes en la pantalla o en los paneles de revisidn, la secuencia de
miniaturas permite realizar las operaciones «arrastrar» y «soltar», segin sea necesario.

Ademas, con un solo clic, el usuario podra seleccionar varias imagenes y, a continuacion,
seleccionar entre las diferentes opciones para guardar las imagenes en una unidad USB, enviar
las imagenes al SACI o borrar las imagenes. Las imagenes seleccionadas apareceran
resaltadas en naranja.

Hay flechas situadas a la izquierda y a la derecha. En caso de que se tomen gran cantidad de
imagenes, pulsando las flechas izquierda o derecha el usuario podra recorrer por fecha
ascendente las imagenes tomadas.

También se incluye la opcion Open the Database (Abrir la base de datos) (véase la
Figura 5.5.3), que entra en el modo Review (Revision). Este mismo boton es el equivalente a
pulsar Review Mode (Modo de revisién) en Home Menu (Menu de inicio). Véanse las
Figuras 5.0.1y 5.6.1.

Se puede entrar en el modo de revisién haciendo clic en el boton Review (Revisar) de la pagina
Home Menu (Menu de inicio), Figuras 5.6.1 y 5.0.1, o en el boton Open Database (Abrir base
de datos) de Current Image Browser (Explorador de imagenes actuales). Véase la Figura 5.5.3.
Al hacer clic en cualquiera de estos botones, se abrira la base de datos como
se muestra en la Figura 5.6.2. Mientras esté en modo de revision, el sistema @
estara en modo de espera.

Review

La base de datos se compone basicamente de tres secciones o subventanas. La seccion
Patient List Table (Tabla de la lista de pacientes) a la izquierda, la seccién Procedure List Table
(Tabla de la lista de procedimientos) en la parte superior derecha y la seccion Image Thumbnail
List/Viewer (Lista/Visor de imagenes en miniatura) en la parte inferior derecha.

Explorador de
imagenes del
paciente actual

Figura 5.5.1
Icono del explorador de imagenes
del paciente actual

Figura 5.5.2
Explorador de imagenes del
paciente actual

Figura 5.5.3
Botén de la base de datos de las
iméagenes

5.6.0
Base de datos

Figura 5.6.1

Icono del modo Review (Revision)
del menu de inicio

Figura 5.6.2
Base de datos de las imagenes
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Como indica la flecha, las tablas de listas funcionan en una jerarquia de arriba hacia abajo: 5.6.0 Cont.

The Patient List (Lista de pacientes) ---> Procedure List (Lista de procedimientos) ---> Image
Thumbnail List/Viewer (Lista/Visor de imagenes en miniatura).

La ventana de seleccion Patient (Paciente) es la ventana superior izquierda. La ventana
Procedure (Procedimiento) es la ventana superior derecha.

Cuando se selecciona un campo Patient (Paciente), se activa la ventana Procedure
(Procedimiento). La ventana Procedure (Procedimiento) muestra una lista de todos los
procedimientos realizados en el paciente seleccionado. Ademas, todas las imagenes
correspondientes al paciente se mostraran en la parte inferior derecha. No es posible
seleccionar a varios pacientes.

Cuando se selecciona un procedimiento, la lista de imagenes en miniatura/visor se filtrara para
mostrar solamente las imagenes que corresponden al procedimiento seleccionado. Se pueden
seleccionar varios procedimientos manteniendo pulsada la tecla Mayusculas y haciendo clic
con el botdon izquierdo del raton en cada procedimiento. Se mostraran las imagenes
correspondientes de los procedimientos seleccionados.

¢ Puede ajustarse la eleccién en la base de datos haciendo clic en los campos superiores, como
Patient ID (Identificacién de paciente) y Last Name (Apellido), para ordenarla por uno u otro
campo. Cuando se haga clic con el cursor del ratén sobre uno de los campos de la base de
datos, se mostrarg un pequefio indicador de flecha dentro del campo. Usando el botdn izquierdo
del ratén y seleccionando el campo de nuevo, la flecha cambiara de ascendente a descendente
o viceversa. El campo seleccionado correspondiente se ordenara automaticamente.

¢ Para facilitar la navegacion, hay barras de desplazamiento en la base de datos.

e Para afiadir automaticamente la imagen a un panel de revision, la lista de miniaturas/visor
permite al usuario hacer clic en el simbolo «+». Un usuario puede afadir hasta cuatro
imagenes en los paneles de revisién. Los paneles de revision se ajustaran automaticamente
para abarcar las cuatro imagenes.

e Las mismas opciones disponibles en Current Patient Images Browser (Explorador de
imagenes del paciente actual) (véase la Figura 5.5.2) estan también ubicadas en la parte
superior de la base de datos. No obstante, también se ofrecen mas opciones, que aparecen
descritas en la seccion 5.5.2.

Nota importante: Las imagenes en miniatura (.PNG) son archivos independientes de los
archivos de datos de imagen reales (DCM, DAT, DMM, RAW). Tienen el mismo nombre de
archivo que el archivo de imagen, pero tienen una extension de archivo (.PNG). Puede que
haya un archivo de imagen sin «miniatura». En ese caso, Vision intentara crear una miniatura
automaticamente para que la imagen se cargue en la base de datos. Sin embargo, si esto no
se pudiera hacer, la imagen no se mostrara.

Save Image(s) (Guardar imagenes)

El boton Save Image(s) (Guardar imagenes) aparece al seleccionar una entrada de Image
Table (Tabla de imagenes) o Thumbnail List (Lista de imagenes en miniatura), o en las
imagenes del paciente actuales; de lo contrario, se desactivara. La imagen seleccionada se
podra guardar en los siguientes formatos de 8 bits: JPEG, BMP, TIFF y RAW. También se
podra guardar en formato TIFF de 16 bits.

El nivel de ventana de la imagen guardada es el nivel de ventana predeterminado. Si el usuario
requiere que el nivel de la ventana esté organizado, debera cargar la imagen en Image View
(Vista de imagen) e imprimir desde alli, en lugar de imprimir desde el cuadro de didlogo de la
base de datos.

Send Image(s) to PACS (Enviar imagenes al SACI):

Esta funcion envia las imagenes a un servidor SACI de DICOM preconfigurado. Para obtener
mas informacién, consulte la seccién 5.7.0.

HOLOGIC

MANUAL DE USUARIO DE FAXITRON PATH | HOLOGIC | REVISION 001

5-28



Faxitron® Path

SECCION

Software
Sistema de radiografia de muestras VISION
Funciones y herramientas del menu de la base de datos o de 5.6.1
imagenes Opciones
Hay funciones para explorar y buscar en la base de datos, adicionales de la
asi como para editar, borrar y afiadir registros a la base de ADDITIONAL OPTIONS base de datos

datos. Estas funciones se explican a lo largo de los
elementos del menu de la base de datos. Se accede a ellas i
desde el botén de nivel superior denominado Additional Print
Options (Opciones adicionales) dentro de la base de datos. View
Search
Tools

Open

Close Database

Menu Open (Abrir)

El menu «Open» (Abrir) solamente tiene una opcion, «Open Image from File» (Abrir imagen
desde archivo), que abre un cuadro de dialogo de Windows que permite al usuario navegar y
abrir archivos de imagen ubicados en unidades locales o de red.

Menu Print (Imprimir)
El menu «DB-PRINT»

(IMPRIMIR BASE DE DATOS) . :
L. . L. Print Image to Local Printer
de imagenes, procedimientos o RitIngels) o DE N RINDE

pacientes. Véase la Figura 4.6.4.

Print Image to Local Printer (Imprimir imagen en la impresora local)

«Print Image to Local Printer» (Imprimir imagen en la impresora local) esta disponible cuando
se selecciona la entrada en la tabla de imagenes o en la lista de imagenes en miniatura; de lo
contrario, estara desactivada. La imagen seleccionada se imprimira utilizando la impresora
local predeterminada del sistema Windows.

El nivel de ventana de la imagen impresa es el nivel de ventana predeterminado. No se
recomienda que los usuarios impriman desde este menu, a menos que estén satisfechos con
las impresiones establecidas en los niveles de ventana predeterminados y calculados por el
programa. El usuario podra cargar la imagen primero en la ventana Image View (Review) (Vista
de imagen [Revision]) y luego ajustar la imagen a los niveles de ventana deseados. Cuando
esté satisfecho con el nivel de la ventana, el usuario podra iniciar la impresion desde el menu
de la ventana de Image View (Vista de imagen). El cuadro de didlogo Format Options (Opciones
de formato) ofrece la posibilidad de elegir entre formatos de impresion.

Print Image(s) to DCM Printer (Imprimir imagenes en una
impresora DCM)

Esta funcion envia las imagenes a una impresora DICOM preconfigurada.

Menu View (Ver)
El menu «View» (Ver) ofrece al usuario una serie de opciones que afectan a la vista de la base
de datos. Véase la Figura 5.6.5.

Print
Show All DB Entries
Search Refresh DB Entries

Tools Browse Data Dir. (No DB)
Browse Any Dir. (No DB)

Figura 5.6.3
Menu Additional Options
(Opciones adicionales)

Figura 5.6.4
Ment Impresion de la base de
datos

Figura 5.6.5
Menu Ver base de datos
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Show All DB Entries (Mostrar todas las entradas de la base de datos)

Recarga la tabla de pacientes desde el archivo de base de datos. Cualquier cambio o adicion a
la base de datos se aplicara a la tabla. Esta seleccion también borrara cualquier Search Filter
(Filtro de busqueda) activo que se haya aplicado a las tablas. Search Filter (Filtro de busqueda)
se explica a continuacion en detalle en el tema Database Search (Busqueda en la base de datos).

Refresh DB Entries (Actualizar entradas de la base de datos)

Actualiza la tabla Patient (Paciente), pero mantiene cualquier filtro de busqueda existente que
se haya aplicado.

Browse Data Directory (No DB) (Explorar el directorio de datos
[no la base de datos])

Muestra todas las imagenes en miniatura en el directorio Data (Datos) establecido por el
archivo de configuracion. Estos archivos se muestran en el Visor de miniaturas. No estan
asociados a la base de datos ni a las listas de tablas. Esta herramienta es util para revisar
imagenes no grabadas o para depurar problemas de la base de datos con imagenes en el
directorio de datos actual.

Browse Any Directory (No DB) (Explorar cualquier directorio [no
la base de datos])

Permite al usuario navegar a cualquier directorio de archivos. Estos archivos se muestran en
el Visor de miniaturas. No estan asociados a la base de datos ni a las listas de tablas. Esta
herramienta es util para revisar un directorio de imagenes que nunca fue grabado en la base
de datos, o cuando los registros de la base de datos estan dafiados.

Menu Search (De busqueda)

Las herramientas de «Search» (Busqueda) de la base de datos, véase la Figura 5.6.6,
proporcionan busquedas detalladas o filtrado de la base de datos. Seleccionando el menu «DB-
Search» (Busqueda en la base de datos) el usuario puede realizar una busqueda detallada y
especifica. Cuando se introducen y activan los criterios de busqueda en el cuadro de didlogo de
busqueda de la base de datos, véase la Figura 5.6.7, el filtro de busqueda se aplicara a todas las
tablas de listas del cuadro de dialogo de la base de datos de imagenes. El criterio de busqueda
activado se denomina Search Filter (Filtro de busqueda) y este filtro permanece activo hasta que
el usuario selecciona «Stfop Search» (Detener busqueda) en el menu «DB-Search» (Busqueda
en la base de datos) o «Show All DB Entries» (Mostrar todas las entradas de la base de datos)
en el menu «DB-View» (Vista de
la base de datos). El filtro de

busqueda activo siempre se Start Search
muestra en el titulo del cuadro de
didlogo Image Database (Base Stop Search

de datos de imagenes).

Start Search (Iniciar busqueda)

«Start Search» (Iniciar busqueda) abre el dialogo de busqueda de la base de datos que permite
al usuario colocar un filtro de busqueda activo en la base de datos. Cuando se abre el didlogo
de busqueda, se cierra la pagina _
Database (Base de datos) y el ' ===
software vuelve a la pagina
Image Acquisition (Obtencion de

SEARCH BY: Enter ACCESSI0M NUMBER

. . s [ oM umb b

imagenes). La pagina Database EEE 2

(Base de datos) se reabrira CLICK 0K~ TO ACTIATE SEARCH FILTER ON THE DATABASE
automaticamente después de =

cerrar el cuadro de didlogo
Search (Buscar).

Los menus desplegables proporcionan una lista de las categorias de busqueda. Seleccione
una categoria de busqueda y escriba el parametro de busqueda deseado para iniciar la
busqueda. Para iniciar la busqueda, seleccione «Start» (Comenzar). Si la categoria puede
tener mas de una entrada discreta, se mostraran todas las entradas de esa categoria.

5.6.1 Cont.

Figura 5.6.6
Menu de busqueda en la base de
datos

Figura 5.6.7
Cémo iniciar una busqueda en la
base de datos
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Stop Search (Detener la busqueda) 5.6.1 Cont.
«Stop Search» (Detener la busqueda) desactiva cualquier filtro de busqueda activo, borra todas
las tablas de la lista y vuelve a cargar la lista de todos los pacientes a la tabla de lista de pacientes.
Menu Tools (Herramientas)
El menu «DB-Tools» (Herramientas de la base de datos) ofrece funciones de imagen,
procedimiento o paciente, asi como algunas funciones utiles para reparar o reformatear la base
de datos. View Figura 5.6.8

Search
Edit Image Record

e B Add Record to DB

Import Records in DIR to DB
Reformat All DB

Edit Image Record (Editar registro de imagen)

La funcién «Edit Image Record» (Editar registro de imagen) no esta disponible actualmente en
el software Vision.

Add Record to DB (Anadir registro a la base de datos)

Disponible cuando se selecciona la entrada de Image Table (Tabla de imagenes) o de
Thumbnail List (Lista de imagenes en miniatura); de lo contrario, estara desactivada. Esto es
especialmente Uutil cuando se navega por un directorio sin que la base de datos tenga entradas
disponibles para las imagenes en ese directorio. El usuario puede seleccionar una sola imagen
de la lista de miniaturas y afiadir registros de esa imagen a la base de datos. Si la entrada de
la base de datos ya existe para la imagen seleccionada, no causara ningun dafio; solamente
puede actualizar la base de datos en términos de dénde se encuentra actualmente el archivo
de imagen, es decir, el nombre del archivo/carpeta.

Import Records in DIR to DB (Importacion de registros del
directorio a la base de datos)

Esta herramienta ayuda a buscar y seleccionar una carpeta y, a continuacion, a rellenar la base
de datos con todas las entradas correspondientes para todos los archivos de imagen del
directorio seleccionado (incluidos los subdirectorios). Los formatos de las imagenes pueden
ser DCM, DAT, DMM y RAW. Si faltan miniaturas de imagenes, esta herramienta también
generara miniaturas de BMP en el mismo directorio.

Reformat All DB (Reformatear toda la base de datos)

La herramienta «Reformat All DB» (Reformatear toda la base de datos) ayuda a reformatear
los campos Date [YYYY/MM/DD] (Fecha [AAAA/MM/DD]), Date/Time [YYYY/MM/DD
HH:MM:SS] (Fecha/Hora [AAAA/MM/DD HH:MM:SS]) de las tablas, y también escribe en
mayusculas las letras de las entradas de algunos otros campos. Es una herramienta util cuando
algun archivo de base de datos méas antiguo se importa y abre por primera vez, o cuando el
usuario altera manualmente las entradas de la base de datos utilizando MS Access.

Notas adicionales en la base de datos

e La posibilidad de salir de la base de datos permaneciendo dentro del modo Revision se
encuentra en Additional Options (Opciones adicionales).

o El boton de la parte superior izquierda se ajustara para llevar al usuario Back to Acquisition
(De vuelta a la obtencion), Back to the Main Menu (De vuelta al menu principal) o se convertira
en el botén Close Database (Cerrar base de datos), dependiendo del flujo de trabajo utilizado
para entrar en la pantalla Database (Base de datos) y de lo que sea mas conveniente.

Menu Herramientas de la base de

datos
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Editar o eliminar de la base de datos la informacion sobre el paciente  5.6.1 Cont.
El usuario puede editar o borrar la informacién sobre el paciente desde la base de datos. Para
abrir un cuadro de dialogo, haga clic con el botén derecho en la entrada del paciente situada
en la seccién superior de la base de datos. Véase la Figura 5.6.9.

Figura 5.6.9

1D6758

D56 2019/03/3 ’
Patient Name:

- N JANE 1]
Patient ID: *
1920/03/23
sex [ ]

1D8679

Edif Patientinformation. . [

Delete Patient Information
Date of Birth:

Al hacer clic en «Edit Patient Information» (Editar
informacién sobre el paciente), se abrira un
cuadro de diadlogo «Patient Information»
(Informacién sobre el paciente). Véase la Figura
5.6.10. Para volver a la base de datos sin realizar <
ni guardar los cambios, haga clic en Cancel
(Cancelar). Al hacer clic en Save Changes
(Guardar cambios), se abrira un cuadro de dialogo de «Confirmation» (Confirmacion). Para
confirmar y continuar, haga clic en Yes (Si). Los cambios se guardaran y el usuario volvera a
la base de datos. No anulara los cambios y volvera a la base de datos. Cancel (Cancelar)
regresara al usuario al cuadro de dialogo «Patient Information» (Informacién sobre el paciente).

Save Changes >

/¥ Nota: Si el sistema tiene activada una contrasefia de puesta en marcha (consulte el tema
Login Utility [Utilidad de inicio de sesidn] en la seccion 5.4.4 y la Figura 5.4.21), se le pedira la
misma contrasefia cuando intente «Delete Patient Information» (Eliminar la informacion sobre
el paciente) en la base de datos.

El estandar DICOM
¢ Qué es el estandar DICOM?

El Estandar de Imagenologia Digital y Comunicaciones en Medicina (DICOM) es una serie de
protocolos utilizados por equipos y software médicos para permitir que los datos sean
compatibles e intercambiables con otros equipos o software médicos.

Cuando se guarda un archivo en formato DICOM, se crea un archivo que incluye los datos
relevantes del paciente, el equipo de obtencion de imagenes, los datos del hardware y los datos
de las imagenes, todo en un solo archivo. Ademas, el archivo guardado contiene caracteristicas
especificas identificadas por el ordenador y el software como archivo de estandar DICOM. Una
vez que una aplicacién de software reconoce el archivo como un archivo de estandar DICOM,
puede iniciar un lector DICOM vy extraer los datos correctamente, independientemente del
origen del archivo.

Un archivo creado utilizando el protocolo DICOM tiene la siguiente estructura:

Preambulo Encakezado
) Prafijo
Cuando el preambulo consta de 128 bytes, todos ellos
normalmente configurados en 00H, a menos que no sean
utilizados por un perfil de aplicacién o una implementacién Ekments de dates
especifica, el prefijo consta. Qe 4 bytes, que constituyen la cgdena Elamentsda dates
de caracteres «DICM» codificada como caracteres en mayuscula
del repertorio de caracteres 1SO 8859 GO, y los elementos de los | Eemente de datas
datos son arbitrariamente grandes (0 pequefios) y contienen los | Ekmento de dates Cenjunte
datos de dates
. Ekments de dates
Ek:ments de dates

Cuadro de dialogo Editar/eliminar
(izquierda)

Figura 5.6.10
Informacién sobre el paciente
(derecha)

5.7.0
Funcionalidad
DICOM

Figura 5.7.1
Estructura del protocolo DICOM
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Modalidad

Para acceder a la configuraciéon de la modalidad de los archivos DICOM, desde la barra de
menu superior, seleccione «DICOM Utilities» (Utilidades de DICOM) y, a continuacion,
«DICOM Modality Setup» (Configuracién de la modalidad DICOM).

DICOM Utilities gl

DICOM MODALITY Setup
DUMP DICOM Header

Es posible seleccionar el tipo de almacenamiento DICOM, ya sea Presentation (Presentacion)
o Processing (Procesamiento). El mismo cuadro de dialogo permite seleccionar la modalidad
de imagen DICOM, ya sea Digital X-Ray (Radiografias digitales) o Digital X-Ray Mammography
(Mamografia digital de rayos X). El usuario no puede definir Transfer Syntax (Sintaxis de
transferencia) ni Value Representation (Representacion de valores). Siempre se asignan para
que sean META HEADER PRESENT (con etiquetas meta en el encabezado), LITTLE_ENDIAN
(extremidad pequefia) y VR_IMPLICIT (realidad virtual implicita).

EDicom Eile/ T ettt

DICOM Storage Type YWalue Fepresentation

{* Storage For Presentation * |rnplicit

(" Storage For Processing (" Ewplicit*

DICOM Image kodality Transfer Syntax

# Digital ¥-ray Image [General) & Litle Endian

(™ Digital -ray Mammography Image " Big Endian®

[l IMPLICITAFR and LITTLE-EMDIAN syntax is recommendead. Other options may
nat be fully compatible with third party software or DICOM services. IMPLICIT AR
and BIG-EMDIAN cannat be simultaneously selected,

Default DICOM Servers
STORE 1|

STORE 2 |
[v Enable Single-Click Auba Store

PRINT |
[ Enable Single-Click Auto Print

MWL |

[v Enable uto Search When Connecting to MWL Server
[¥ Enable Single-Click Auto ML Connection

[ Autocloze dialog after 5 zeconds of successiul ransfer/printing.

Click DICOM Servers button to add. configure
DICOM Servers... | o delste DICOM servers.
[u]8 | Cancel

@ Nota: Cuando las modalidades DICOM se han seleccionado, permanecen en efecto incluso
después de que el software Vision se ha cerrado. Los ajustes de modalidad se almacenaran y
permaneceran en la forma configurada hasta que se cambien de nuevo utilizando DICOM File
Settings (Ajustes del archivo DICOM). Estos ajustes (Storage Type & Modality, Transfer Syntax
y Value Representation) (Tipo y modalidad de almacenamiento, sintaxis de transferencia y
representacion de valores) seran efectivos para todas las funcionalidades DICOM Local Save
(Almacenamiento local) o Print (Impresion).

5.7.0 Cont.

Figura 5.7.2
Menu Utilidades de DICOM

Figura 5.7.3

Ajustes de la modalidad DICOM
Se muestran los ajustes
predeterminados
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Default DICOM Servers (Servidores DICOM predeterminados)

Esta seccion contiene la configuracion para los servidores DICOM predeterminados y para
automatizar algunos de los procesos al almacenar, imprimir o buscar servidores SACI y MWL.

Las casillas de verificacion «Enable Single-Click Auto Store» (Activar almacenamiento
automatico con un solo clic), «Print» (Imprimir) o «c MWL Connection» (Conexion MWL) permiten
al usuario almacenar o imprimir imagenes, o conectarse automaticamente al servidor MWL. Si
usted utiliza un solo servidor SACI para esas acciones o la mayoria de su trabajo involucra un
solo servidor SACI, marque la casilla deseada para automatizar esas acciones.

«Enable Auto Search When Connecting to MWL Server» (Habilitar la busqueda automatica al
conectarse al servidor MWL) le indicara a la aplicacion que realice automaticamente una
busqueda con la configuracion de busqueda predeterminada al buscar los datos del paciente.

El cuadro de didlogo «Auto close dialog after N seconds of successful transfer/printing» (Cierre
automatico después de N segundos de transferencia o impresidon correcta) cerrara
autométicamente el cuadro de dialogo DICOM Networking (Trabajo en red DICOM)
transcurrido un numero especificado de segundos. Si hubo un error en la transferencia o la
impresion, el dialogo no se cerrara automaticamente.

Al hacer clic en el boton DICOM Servers (Servidores DICOM), se abrira el cuadro de dialogo
DICOM Networking (Trabajo en red DICOM), donde el usuario podra afiadir, modificar o
eliminar servidores DICOM. Véase la Figura 5.7.5.

DICOM Save Local (Guardar como DICOM local)

Para guardar la imagen actual en una unidad local o directorio, haga clic con el botén derecho
en cualquier parte de la imagen. Esto mostrara el cuadro de didlogo que se muestra en la
Figura 5.7.4 siguiente. Haga clic en «Save/Store current image» (Guardar/almacenar imagen
actual) y, a continuacion, en «As local
DICOM image» (Como imagen
DICOM local). Se abrira el cuadro de
dialogo Windows File Save (Guardar
archivo de Windows) estandar.
Busque o haga clic directamente en la
carpeta deseada, introduzca el
nombre del archivo y haga clic en
Save (Guardar).

LI IETE CUITENT IMAge recora

Add new record

Save/Store current image 3

LIS Archive image
As local DICOM image

As local image

Print current image 3

More options...

PACS Store and PACS Print (Almacenamiento en SACI e
impresién en SACI)

El software Vision permite el almacenamiento en SACI (DICOM) y la impresion en SACI
(DICOM). Estas opciones estan disponibles en todo el software. Por ejemplo, si se selecciona
el boton PACS Store 2 ocomneuong vues - i = = =i
(Almacenamiento en SACI),
se podra mostrar la siguiente ~ E=ll

SESSION SECURITY VIEW COMMAND PREFERENCES

[=] 0ICOM Network Connections

ventana de didlogo de |— = [ m =
Conexiones de red D|COM M DICOM Store 1 DICOM Print 1 TR
Este cuadro de didlogo %

permite al usuario realizar un Dol oot Hesieocy boo
DICOM Store

(Almacenamiento en

DICOM), una DICOM Print

(Impresién en DICOM) o Add | __«onn |

(Agregar), Modify (Modificar)

o Remove DICOM Network —]

connections (Eliminar

conexiones de red en

DICOM) o  Peripherals S

(Periféricos).

5.7.0 Cont.

Figura 5.7.4
Cuadro de dialogo Guardar
imagen actual

Figura 5.7.5
Cuadro de dialogo Conexiones de
red DICOM
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PACS DICOM Store (Almacenamiento en DICOM como SACI) 5.7.0 Cont.

El software Vision es compatible con el servicio DICOM 3.0 C-STORE. Esto permite enviar una
imagen o una serie de imagenes (bajo un procedimiento especifico) a un sistema de
almacenamiento remoto compatible con la entidad de aplicacion DICOM (AE), como, por
ejemplo, SACI. Una vez mas, la capacidad DICOM Store (Almacenamiento en DICOM) esta
prevista en todo el software Vision. Las modificaciones de Presentation (Presentacion) y
Processing (Procesamiento) se pueden realizar a través de DICOM Modality Setup
(Configuracion de la modalidad DICOM) bajo el menu Tools (Herramientas).

& Nota: En DICOM Store (Almacenar en DICOM), «SET FILM Attributes» (Ajustar atributos
de la pelicula) se muestran en gris.

El usuario puede afadir una nueva configuracion para una entidad de aplicacion (AE) de
DICOM remota a la que enviar la imagen o seleccionar una ya configurada, que se muestra en
las conexiones DICOM Network (Red de DICOM) en el cuadro de dialogo DICOM Networking
(Conexiones de red de DICOM). Haciendo doble clic (o un solo clic y presionando el botén
Connect [Conectar]) en el icono de la entidad de aplicacion (AE) de DICOM remota, el software
Vision se conectara y establecera una asociacion DICOM con la AE remota seleccionada. Una
vez que la asociacion se haya establecido con éxito, la imagen se podra enviar para su
almacenamiento pulsando el botdn Store (Almacenar). Después de seleccionar el boton Store
(Almacenar), el software Vision enviara la imagen seleccionada a la AE de DICOM remota
definida. Si la operacion de almacenamiento tiene éxito, la AE de DICOM remota enviara una
confirmacion de recepcion y almacenamiento de las imagenes. Si la operacion falla, la AE de
DICOM remota enviara un codigo de error indicando la razén del fallo.

Una sola imagen también puede ser enviada para su almacenamiento haciendo clic en el botén
derecho del ratén sobre la imagen en «miniatura» mientras esta en el navegador de la base de
datos y siguiendo el mismo procedimiento descrito anteriormente. Es posible enviar una Series
(Procedure) (Serie [Procedimiento]) completa de imagenes para su almacenamiento. Esto se
logra haciendo clic en el botén derecho del raton en el nombre de la Series (Procedure) (Serie
[Procedimiento]), que aparece en la pantalla del navegador de la base de datos y de nuevo,
siguiendo el mismo protocolo descrito anteriormente.

Add Session (Agregar sesion)

El boton Add Session (Agregar sesién) abre el cuadro de didlogo Session (Sesion) a través del
cual el usuario puede configurar una nueva conexion a una entidad de aplicaciéon DICOM remota.

Para crear una nueva configuracién de conexién a una AE de DICOM remota, el usuario debera
tener disponible la siguiente informacion: Application Entity Title (AE Title) (Titulo de la entidad
de aplicacion [titulo AE]), la eleccién de «function to perform» (Funcién que se va a realizar) de
DICOM/SACI, IP Address (direccion IP) y Port Number for the Sever (Numero de puerto para
el servidor [es decir, la impresora DICOM o el sistema SACI)).

El titulo AE y el numero de puerto del sistema del usuario (es decir, el cliente) también son
obligatorios. Para crear una nueva configuracion, rellene los campos de datos pertinentes y
seleccione OK (Aceptar).

Seleccién del comportamiento de la funcién de sesion

predeterminada de DICOM/SACI Figura 5.7.6
Actualmente existen cuatro (4) tipos de funciones | DICOM Session Properties i Cuadro d.e’ didlogo Propiedades
que una sesion DICOM puede representar por Mg | oK de la sesion
defecto. Estos se encuentran en la lista desplegable S =

Function (Funcién) (cuadro combinado) que se METe [
muestra en la siguiente figura. También hay una lista

) ., Funclion: GEMERAL -
a continuacion: GENERAL
STORE
.. . |PRINT
1. Una conexion DICOM/SACI GENERAL e

Port Number: |0

2. Una conexion ALMACENAMIENTO EN DICOM

.y Client
3. Conexion de una IMPRESORA DICOM e T
4. Una conexién LISTA DE TRABAJO de modalidad Portumbee [0
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El propdsito de la «funcién» DICOM es permitir la creaciéon de una sesion o conexion (afiadida)
que permita que un «dispositivo» DICOM/SACI solamente pueda ser utilizado tal y como el
usuario lo ha configurado para una categoria de funcioén en particular. Una vez configurado, al
visualizar o utilizar «<DICOM Networking Dialog» (cuadro de didlogo Conexiones de red de
DICOM) (véase la Figura 5.7.5 anterior), solamente estara «activo e iluminado» el icono
correspondiente a la funcidn elegida. Es decir, tendra un color azul en lugar de un color
«grisaceo». Por ejemplo, en la Figura 5.7.5 superior hay tres (3) iconos que representan, en
orden: un almacenamiento en DICOM (DICOM Store 1), una impresion en SACI (DICOM Print
1) y una lista de trabajo de modalidad (DICOM-MWL). Debido a que el boton DICOM Store
(Almacenamiento en DICOM) fue elegido previamente, es el Unico que esta activo (pantalla
azul). Asimismo, funciona igual para los otros modos.

Modify Session (Modificar sesién)

El boton Modify Session (Modificar sesion) abre el cuadro de didlogo para la entidad de
aplicacién (AE) de DICOM seleccionada. En esta ventana, el usuario puede modificar la
informacién del servidor y del cliente descrita en la descripcion de Add Session (Agregar
sesion).

Remove Session (Eliminar sesién)

El boton Remove Session (Eliminar sesion) elimina la configuracion de la entidad de aplicacién
(AE) de DICOM seleccionada en el software Vision. Una vez eliminada, la configuracién de la
entidad de aplicacion (AE) de DICOM no se podra restaurar a menos que el usuario vuelva a
introducir manualmente los datos necesarios mediante el botén Add Session (Agregar sesion).
Se solicitara una confirmacion de la accion; véase mas adelante.

r ]
Vision

5.7.0 Cont.

Figura 5.7.7

Verificacion de la eliminacion de
una conexioén de red DICOM

existente
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Association (Asociacion) 5.7.0 Cont.
El boton Association List (Lista de Asociaciones) abre el cuadro de didlogo Association
(Asociacion), representado abajo, mediante el cual el usuario puede editar los parametros y
protocolos utilizados por el software Vision cuando negocia una conexién con una entidad de
aplicaciéon (AE) de DICOM remota. Estas opciones solamente deben ser modificadas por un
usuario avanzado que esté familiarizado con los protocolos de asociacion de DICOM.
~ Figura 5.7.8
@5 DICOM Association Lé] Ventana Asociacion DICOM
Wersion: 1
Application Contest: |1 .2.840.10003.3.1.1.1
Caticel
b ax Data Lenagth: 16384 ¥ Enabled
Implernentation Class: |1.2.84D.11425?.1123455 ¥ Enabled
Implementation Yersion: |1 [¥ Enabled
tax Operation lrvoked: ™ Enabied
tax Operation Performed: DS
Heruzel BT Yerification Class -
B asic: Film Session Class I Select Al
Basic Film Box Class |5
Bazic Grayzcale Image Box Class i Deselect Al
Bazic Grayzcals Print banagement Meta Class Mo
PFrint Job Clazz oo,
Basic Annotation Box Clazs
: . Drefault
Printer Clazz
1| 1] b
Timeout [rs]: E0000

Film Attributes (Atributos de la pelicula)

Al seleccionar «SET DICOM PRINT FILM Attributes» (Ajustar atributos de la pelicula de la
impresora DICOM) en el meni « COMMAND» (Figura 5.7.9) aparecera el cuadro de dialogo
DICOM Printer Setup (Configuracion de la impresora DICOM). Véase la Figura 5.7.10. En este
cuadro de didlogo, el usuario podra seleccionar varias opciones que rigen el formato de la
pelicula y la impresion. Al seleccionar Default (Predeterminado), se restauran todas las
opciones predeterminadas. Las configuraciones de los ajustes se proporcionan a través de
menus desplegables. Para aceptar la configuracion modificada, seleccione OK (Aceptar). Para
rechazar las opciones y salir de la ventana sin realizar ninguna modificacién, seleccione Cancel
(Cancelar).
;"tlz__.l, DICOM Metworking Dialog - Bioptics Vision

SESSION  SECURITY VIEW COMMAND PREFERENCES

: ECHO ON/OFF
| CHECK ASSOC. FOR STORAGES
ADD Session |
SELECT DICOM File & DICOM STORE
MODIFY Session | 0} DICOM STORE Selected
REMOVE Session | SELECT DICOM File & DICOM PRINT
ASSOCIATION List | SET DICOM PRINT FILM Attributes

DIC DICOM PRINT Selected
DISCOMMECT |
ECHO ON/OFF I

DICOM C-FIND Patient Root...
DICOM C-FIND Study Root...
DICOM C-FIND Patient/Study Only

DICOM C-FIND Modality Worklist...

DICOM RETRIEVE

CANCEL Command

Figura 5.7.9
Establecer los atributos de la
pelicula de la impresora DICOM
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5.7.0 Cont.
DICOM Printer Setup X
Figura 5.7.10
: Cuadro de dialogo Configuracion
Medium Type ¥ de la impresora DICOM
Print Priarity |High -

MNumber of Copies |1

Film Destinatian |Magazine

Film Orientation |Parrait

Empty Image Density |El|ack

Border Density |Ellack

Magnification Type | REPLICATE

Film Size ID |BINX10IN

Falarity |N0rmal

Sroothing Type |Medium
Film Density

hax Density Wﬂ
Min Density |0 4

Image Display Format

. B
@ STANDARD, m m

 Slide

Default 0K | Cancel

Be 1 1t b e e e e e 1

PACS Print (Impresién en SACI)

La opcién PACS Print (Impresion en SACI) envia la imagen seleccionada a la impresora SACI
DICOM seleccionada. La imagen se imprimira de acuerdo con las opciones de formato de
pelicula y de impresién que se encuentran en el cuadro de didlogo Set Film Attributes
(Establecer atributos de pelicula) descrito anteriormente. Si el usuario inicia la impresion en
SACI desde Image View (Vista de imagen), el nivel de la ventana sera elegido desde la vista
de imagen. Si la impresion en SACI se inicia desde el diadlogo de base de datos, el nivel de
ventana sera el nivel de ventana por defecto calculado por el software Vision.

Close (Cerrar)

El botén Close (Cerrar) cierra el cuadro de dialogo DICOM Networking (Conexiones de red de
DICOM) y devuelve al usuario al area desde la que se ejecutd el comando DICOM. Este
comando también cerrara la conexidon o asociacion entre el software Vision y el dispositivo
DICOM remoto, si se ha establecido una conexion.
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Descripcion general 5.8.0

Las anotaciones de usuario dentro del software Vision permiten aplicar a una imagen una
«sobreimpresion» grafica transparente, comunmente Illamada «anotaciones». Estas
anotaciones adoptan la forma de texto, lineas, lineas de «forma libre» (curvas de Bezier),
flechas, elipses y cuadros. Esto permite afiadir informacién adicional y «marcadores» a la
imagen, si se desea. Tenga en cuenta que todas las anotaciones se pueden activar o desactivar
facilmente; en otras palabras, se pueden mostrar u ocultar a voluntad.

Funcionamiento

Para comenzar a anotar, seleccione la herramienta Annotations (Anotaciones) del menu de
la izquierda. Véanse las Figuras 5.4.1 y 5.8.1. Al abrir este cuadro de dialogo, el software
pondra inmediatamente al usuario en modo de disefio. También mostrara una «paleta de
herramientas». Véase la Figura 5.8.2 siguiente.

Al seleccionar Save (Guardar) o Cancel (Cancelar) en este cuadro de dialogo, se cancelaran
las anotaciones anteriores o se guardaran las anotaciones actuales en la ventana. También le
devolvera a usted al modo normal de obtencién de imagenes.

La paleta de herramientas consta de quince (15) opciones de herramientas que se muestran a
continuacién. Sin embargo, las herramientas pueden ser truncadas en funcidon de las
necesidades del usuario a las 8 herramientas mas comunes, que se muestran en la fila superior
del cuadro de didlogo.

Tenga en cuenta que el comportamiento de la mayoria de estas opciones de herramientas
implica utilizar el ratdn para guiar la posicién y la forma dinamica en pantalla. Los «clics» del
raton se utilizan para establecer la posicion y la forma definitivas. El término «deslizar» implica
mantener pulsado el botén izquierdo del ratdn y mover el objeto por la pantalla. Si se suelta el
botdn izquierdo del raton o se hace clic con el botdn derecho del raton, la anotacién se colocara
en una posicion «permanente» o definitiva.

Mew Preset Name Here

Add as New Preset

Partiendo de la parte superior izquierda de la figura anterior, a continuacién se ofrece una
descripcion de cada opcién de herramienta.

Anotaciones del
usuario

Figura 5.8.1
Icono de Anotaciones

Figura 5.8.2
Paleta de herramientas de disefio
de anotaciones de usuario
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o Herramienta Selection (Seleccién): se utiliza para seleccionar (resaltar) un objeto de la 5.8.0 Cont.
anotacion actual. Haga clic y mantenga pulsado el botdn izquierdo del ratén, que establece
una posicion inicial y, a continuacion, mueva el ratén. Cualesquiera que sean las anotaciones
que se encuentren dentro del cuadro que se esta mostrando, seran seleccionadas para
utilizarlas posteriormente. Para finalizar la operacién, suerte el botén izquierdo del ratén.

¢ Herramienta Line (Linea): dibuja una linea recta con esta opcion. EI comportamiento del
ratén es el mismo que el de arriba.

¢ Herramienta Box (Cuadro): dibuja un cuadro. El comportamiento del ratén es el mismo que
el de arriba.

¢ Herramienta Ellipse (and Circle) (Elipse [y circulo]): dibuja una elipse o un circulo. El
comportamiento del ratén es el mismo que el de arriba.

e Herramienta Arrow (Flecha): dibuja una linea con una flecha al final. El comportamiento
del raton es el mismo que el de la herramienta Line (Linea).

e Herramienta Polygon Open Line (Linea abierta poligonal): dibuja lineas no rectas
«segmentadas y abiertas». Haga clic con el botén izquierdo del ratén, mantenga pulsado el
botdn y dibujelo. Para fijar un segmento de linea, suelte el botén izquierdo. Repitalo cuantas
veces lo desee. Haga clic con el botdn derecho del raton y la operacion de la herramienta
habra finalizado.

e Herramienta Text (Texto): crea un «cuadro de texto» donde se pueden escribir datos
basados en texto.

¢ Herramienta Ruler (Regla): crea un segmento de lineas paralelas. Muy parecida a la
funcion Image Tools Ruler (Regla de herramientas de imagen).

e Herramienta Polygon Closed Line (Linea cerrada poligonal): dibuja lineas no rectas
«segmentadas y cerradas». Haga clic con el botén izquierdo del raton, mantenga pulsado el
botén y dibujelo. Para fijar un segmento de linea, suelte el botén izquierdo. Repitalo cuantas
veces lo desee. Haga clic con el botdn derecho del raton y la operacion de la herramienta
habra finalizado.

¢ Herramienta Curved Open Line (Linea curva abierta): dibuja lineas curvas «abiertas y
segmentadas» (curvas de Bezier). Haga clic con el botén izquierdo del raton, mantenga
pulsado el botén y dibujelo. Para fijar un segmento de linea curva, suelte el botén izquierdo.
Repitalo cuantas veces lo desee. Haga clic con el botén derecho del raton y la operacion de
la herramienta habra finalizado.

e Herramienta Curved Closed Line Tool (Linea curva cerrada): dibuja lineas curvas
«segmentadas y cerradas» (curvas de Bezier). Haga clic con el botdn izquierdo del ratén,
mantenga pulsado el botén y dibujelo. Para fijar un segmento de linea curva, suelte el botén
izquierdo. Repitalo cuantas veces lo desee. Haga clic con el botdon derecho del ratéon y la
operacioén de la herramienta habra finalizado.

e Herramienta Text «Balloon» (Globo de texto): crea un cuadro de texto con un segmento
de linea que sobresale de una esquina del cuadro de texto. Esto se puede utilizar para
«enlazar» texto a algo que esté en la imagen que usted haya obtenido.

e Segmented Ruler (Regla segmentada): dibuja lineas no rectas paralelas «abiertas y
segmentadas». Haga clic con el botén izquierdo del ratén, mantenga pulsado el botén y
dibujelo. Para establecer un segmento de lineas paralelas, suelte el boton izquierdo. Repitalo
cuantas veces lo desee. Haga clic con el botén derecho del ratéon y la operacion de la
herramienta habra finalizado. La longitud de todos los segmentos de lineas paralelas se
muestra al final de la regla. Util para una estimacién aproximada de la periferia de un objeto
0 paciente.

¢ Herramienta Protractor (Escuadra): dibuja un angulo en la pantalla y proporciona el grado
del angulo. Igual que una escuadra.

¢ Herramienta Orthogonal Ruler (Regla ortogonal): Proporciona dos (2) lineas paralelas
que son ortogonales entre si.
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Modo de disefio y menu contextual del ratén 5.8.0 Cont.
En el modo de disefio de anotaciones de usuario, pero no en un modo de operacién especifico,
se puede hacer clic con el boton derecho del ratdn y obtener un menu contextual. Véase mas
abajo.
Name... Figura 5.8.3

Line...

ROP2...

Transparent

Transparent Color...

Fill...

Foreground Color...
Background Color...

Text Color...

Mote Background Color..,
Redact Background Color...
Hilite Background Color...
Font...

Button Font...

E Unde Hotspot Metafile...
| Cut Encrypt Metafile...
Copy Decrypt Metafile...
Paste Ruler...
Delete Modes...
Protractor...

Select All
Show Stamp Border

Bring to Front Point...

Send te Back

Encrypt...
Hide Rotate Handles for All Objects Fixed...
Default Properties » Hyperlink...

Desde estos menus contextuales se pueden realizar muchas configuraciones especificas.

@ Nota: Si un elemento parece demasiado pequefio para leerlo o verlo correctamente, usted
lo podra cambiar desde los menus contextuales del ratdbn mostrados mas arriba. De forma
alternativa, podra elegir hacer zoom en la imagen utilizando la herramienta Dynamic Zoom
(Zoom dinamico). Esto ampliara la imagen y usted deberia poder ver claramente cualquier
anotacion.

Mostrar u ocultar las anotaciones

El botén Toggle Annotations (Alternar anotaciones), que se muestra en la

Figura 5.8.4, permite a los usuarios activar y desactivar rapidamente las
anotaciones. Por defecto, las anotaciones estaran activadas. El boton se encuentra E
en el menu del lado derecho, cerca de la esquina superior derecha.

Clic con el boton derecho del
raton en el menu contextual
(solamente durante el modo de
disefio de las anotaciones de
usuario)

Figura 5.8.4
Opcion mostrar/ocultar para las
anotaciones del usuario
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Faxitron® Path

SECCION

Software
Sistema de radiografia de muestras VISION
El submenu «Help» (Ayuda), véase la Figura 5.9.1, se encuentra en la barra de menu superior 59.0

y permite un acceso rapido al «User’'s Manual» (Manual de usuario) y a «About Vision» (Acerca
de Vision) de Faxitron Path. Consulte la seccion 5.10.0 y la Figura 5.10.1.

] Open User's Manual
[
|_.

About Vision

El boton «About Vision» (Acerca de Vision) abre un cuadro de dialogo que muestra la version
del software Vision, la fecha de la propiedad intelectual y la informacién del sistema.

About Vision >

[:] Vision Version 3.1 4 Revl U (84-Bij

Copyright (C) 2005-2018 Faxitron Bioptics LLC

— Processing Library Information
Yersiond 3.0.3.1 MName: FEBProcessing.dll

——— Camera Librany Information
Yersiond 1.0700 Mame: BiCamTLDS.dll

Canfiguration Utility Information
“Yarsion# 1.2.1.1

————  Camera Infarmation

Make: Teledyne Dalsa, Serial# SERIALY
Madel: Xineos 2923

Sensortype: TDOLS_2304X2944

— r-Ray System Infarmation
hake: BIOFTICS, hodel: PATHWISION
Firrmware Wersion# PAT01.05

Acerca de la Ayuda

Figura 5.9.1
Cuadro de diélogo Ayuda en linea

5.10.0
Acerca del
software Vision

Figura 5.10.1

Cuadro de dialogo con
informacion acerca de Vision
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Faxitron® Path SECCION 6

Sistema de radiografia de muestras y seguridad

SECCION 6

Requisitos de
cumplimiento y medidas de
seguridad
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Faxitron® Path SECCION

Sistema de radiografia de muestras y seguridad

Requisitos | Cumplimiento de Faxitron Path 6.1.0

Limites de emision ReQUIS.It(_)S de
La radiacion de rayos X emitida por la unidad Faxitron Path no excede una exposicion de cumpllmlento
0,1 mili-Roentgens (mR) por hora en cualquier punto a 5 centimetros (cm) (2 in) fuera de la y medidas de
superficie externa. Para los paises que exigen valores de emision medidos a 10 cm de la seguridad
superficie exterior, la radiacién no supera los 0,1 mR por hora a 10 cm.

Enclavamientos de seguridad
El sistema Faxitron Path de radiografias digitales de especimenes tiene dos enclavamientos
de seguridad en la puerta de los especimenes.

Boton Start (Inicio)
Tras la interrupcion de la generacion de rayos X por los enclavamientos de seguridad, el boton
Start (Inicio) del panel frontal reanudara la generacion de rayos X cuando esté listo.

Control accionado por llave

El interruptor de cerradura con llave situado en el panel frontal requiere que se inserte y se
gire una llave en el sentido de las agujas del reloj hasta la posicién de las 3 para suministrar
energia al sistema de armario. La llave se mantiene fijada en la posicién «ON» (Encendido).

Botén Emergency Stop (Parada de emergencia)

En el panel frontal, Faxitron Path incluye el boton Emergency Stop (Parada de emergencia)
para detener la generacion de rayos X. Esto se suma a los enclavamientos de seguridad de
las puertas del sistema.

Indicadores de generacion de rayos X
El Faxitron Path tiene un indicador luminoso de rayos X en el panel frontal y en la interfaz
grafica de usuario, y produce también un tono audible cuando se generan los rayos X.

Potencias nominales
Maximo de 100-240 VCA, 50/60 Hz, 200 W

Potencia calorifica
Maximo de 500 BTU/h (527,5 kJ/h)

LOCALIZADOR LASER
El Faxitron Path utiliza un par de lineas generadas por laser que facilitan el posicionamiento
de las muestras en el centro del campo de generacién de imagenes.

Parametros del laser

Cumple con la norma IEC 60825-1:2007
Producto laser de clase 2

Longitud de onda: 670 nm

Potencia maxima: 2 mW

Anchura de linea: tipicamente, 1 mm
Divergencia del rayo: tipicamente, 85°

Los laseres no requieren montaje.

No hay un proveedor autorizado de mantenimiento para los laseres. El mantenimiento de los
laseres debe llevarlo a cabo Unicamente un representante autorizado de Hologic.

PARAMETROS ELECTRICOS DEL LASER

Tension de funcionamiento:  rojo, 3-6VDC
negro, Tierra

Corriente de funcionamiento: tipicamente, 50 mA
maxima, 80 mA
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Faxitron® Path SECCION

Sistema de radiografia de muestras y seguridad

PRECAUCIONES: ) 6.1.0 Cont.
RADIACION LASER DE CLASE 2 CUANDO LA PUERTA ESTA ABIERTA. NO MIRE
FIJAMENTE AL RAYO.

Los rayos laser pueden provocar dafios en los ojos, NO mire a la abertura del laser mientras
este esté en funcionamiento.

Tenga en cuenta que la luz laser también puede ser peligrosa si se refleja en una superficie
similar a un espejo.

Para obtener mas informacion acerca de los laseres, consulte la NORMA NACIONAL

NORTEAMERICANA PARA EL USO SEGURO DE LASERES ANSI Z1 36.1, disponible
a través del Laser Institute of America (teléfono 407-380-1553).

@ NOTA: Las aberturas del laser se encuentran en la parte superior del compartimento de
rayos X.

Etiqueta de PRECAUCION del laser: en la esquina superior derecha de la puerta.

/_ LASER RADIATION

AVOID DIRECT EYE EXPOSURE
CLASS 2 LASER PRODUCT
PEAK POWER ZmW
WAVELENGTH 670NM

RAYONNEMENT LASER EVITEZ TOUTE
EXPOSITION DIRECTE PRODUIT LASER DE
CLASSE 2 POWER PEAK 2w LONGUEUR

D'ONDE 670nmLASER RADIATION

\ IECﬁﬂﬂzj-y

COMPLIES WITH 21 CFR 1040.10
AND 1040.11 EXCEPT FOR DEVIATIONS
PURSUANT TO LASER NOTICE NO.50,
DATED JULY 26, 2001

CAUTION/ATTENTION

CLASS 2 LASER RADIATION WHEN OPEM
DO NOT STARE INTO BEAM

RAYONMEMENT LASER DE CLASSE 2 EN
CASD'OUVERTURE NE PAS REGARDER
DANS LE FAISCEAU

P/N 7120-6300-1
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Faxitron® Path

SECCION
Conformidad

Sistema de radiografia de muestras y seguridad
. 6.2.0
Version de DICOM Estandar DICOM

Hologic utiliza el ultimo estandar DICOM:

Imagenologia Digital y Comunicaciones en Medicina (DICOM) v3.0, desarrollado por ACR-

NEMA, version definitiva, agosto de 1993.

Y cumple el estandar:

NEMA PS 3.1-3.20 (2016), Equipo de Imagenologia Digital y Comunicaciones en Medicina

Clases de almacenamiento

FAXITRON_DR cumple la norma relativa a la siguiente clase SOP (par servicio-objeto) de

DICOM V3.0 como SCU (usuario de clase de servicio).

Clase SOP como SCU

Clase SOP

UID (identificador unico) de clase SOP

SOP de almacenamiento de imagenes de
radiografias computarizadas

1.2.840.10008.5.1.4.1.1.1

Presentacion del almacenamiento digital de
imagenes realizadas con rayos X

1.2.840.10008.5.1.4.1.1.1.1

Procesamiento de imagenes digitales realizadas
con rayos X

1.2.840.10008.5.1.4.1.1.1.1.1

Presentacion del almacenamiento de imagenes
digitales de mamografias realizadas con rayos X

1.2.840.10008.5.1.4.1.1.1.2

Procesamiento de imagenes digitales de
mamografias realizadas con rayos X

1.2.840.10008.5.1.4.1.1.1.2.1

Consulta o recuperacién de la informacion raiz
del estudio. Modelo -FIND

1.2.840.10008.5.1.4.1.2.2.1

Consulta o recuperacion de la informacion raiz
del paciente. Modelo -FIND

1.2.840.10008.5.1.4.1.2.1.1

Modelo -FIND de informacion de las listas de
trabajo de las modalidades

1.2.840.10008.5.1.4.31

IAlmacenamiento de la presentacion de las
copias digitales en escala de grises

1.2.840.10008.5.1.4.1.1.11.1

Para conocer mas detalles, consulte en su totalidad la declaracion de conformidad de DICOM,
que esta almacenada en el sistema. El archivo esta en C:\Faxitron, y hay un acceso directo

en el escritorio.

Si la necesita, puede solicitar a Hologic una copia de la declaracion de conformidad de

DICOM.
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Faxitron® Path Voonmisnto y 7

Sistema de radiografia de muestras resolucion de problemas

SECCION 7
Mantenimiento y
resolucion de problemas
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Faxitron® Path Mooy

Sistema de radiografia de muestras resolucion de problemas

Mantenimiento 7.1.0
Mantenimiento y

En los equipos Hologic no hay piezas que se puedan reparar. Para recibir asistencia técnica, .
auw 9 yP d P P resolucioén de

pongase en contacto con el representante autorizado de Hologic.

problemas
EE. UU.: +1.877.371.4372
Europa: +32 27114690
Asia: +852 37487700
Australia: +1 800 264 073

Resto del mundo: +1781 999 7750

Correo electronico:  BreastHealth.Support@hologic.com

Solucién de problemas

El ordenador o el sistema no se encienden
El ordenador o el sistema de rayos X no estan recibiendo alimentacion eléctrica.
Compruebe que el sistema esté encendido y que la regleta esté enchufada y encendida.

La luz LISTO no permanece encendida
Se presiond el botdon ANTES de que el software Vision estuviera en marcha o antes de que
preparara el sistema de rayos X para obtener una imagen. Consulte la seccion Inicio rapido.

En la imagen parece como si en la radiografia hubiera otro objeto
Compruebe si durante la calibracion habia algun objeto en la cabina de rayos X. Retire
cualquier objeto y repita la calibracién.

La imagen tiene mala calidad

Compruebe que los valores de intensidad de la imagen (I (x,y)) que se encuentran en la
esquina inferior derecha de la ventana de visualizacién de la imagen estén cerca de
10 000 UAD, que el objetivo AEC predisparado esté también ajustado a 10 000 UAD y que el
modo de exposicion esté seleccionado como Auto kV/Auto Time (kV automatico/tiempo
automatico). Si fuera necesario, repita el procedimiento de obtencion de imagenes.

Ciberseguridad

Si se produce un evento de ciberseguridad, desconecte de la red el sistema y pongase
inmediatamente en contacto con Hologic. Trabajaremos con el departamento de Tl del centro
para resolver el problema.

Un evento de ciberseguridad puede detectarse de varias maneras:
e El funcionamiento y/o la conexién de red son mas lentos de lo normal.

e En el navegador de Internet aparecen ventanas emergentes sospechosas o la
pagina de inicio ha cambiado.

e La(s) contrasena(s) ya no funciona(n).
e En el menu de inicio o en la bandeja del sistema hay programas desconocidos.

e Los datos se han perdido, dafiado o alterado.
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Faxitron® Path SECCION. 8

Sistema de radiografia de muestras mantenimiento

SECCION 8
Programa de
mantenimiento
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Faxitron® Path

Sistema de radiografia de muestras

SECCION

Programa de
mantenimiento

Este documento proporciona un programa de pruebas y mantenimiento para Faxitron Path.
Para garantizar que el generador de rayos X Faxitron siga funcionando con un rendimiento
6ptimo, se recomienda encarecidamente que el mantenimiento y las pruebas descritas en esta

8.0.0
Mantenimiento

seccion se realicen en los intervalos de tiempo indicados.

Advertencia: Las muestras que contienen tejidos pueden albergar agentes
infecciosos que son peligrosos para la salud. Siga los correspondientes
procedimientos de bioseguridad; cuando manipule especimenes de tejido o los

materiales con los que entren en contacto, utilice guantes.
Limpie periddicamente el interior del armario con alcohol isopropilico al 70-90 % o hipoclorito
de sodio diluido (la lejia doméstica al 5,25 %-6,15 % diluida en la proporcién 1:500 ofrece la
concentracion adecuada). Asegurese de que el area de especimenes, marcada en la base de
la camara, esté bien limpia.

No utilice acetona ni otros disolventes agresivos en la ventana de la puerta del compartimento
de rayos X.

8.1.0
Interno

Limpie periddicamente las superficies exteriores con alcohol isopropilico, hipoclorito de sodio,
0 agua con jabén suave (consulte las concentraciones adecuadas en la seccién 8.1.0). No
empape ni inunde las superficies, ni utilice abrasivos que puedan rayarlas. No permita que la
humedad entre en contacto con ninguno de los componentes eléctricos del sistema. Para
verificar que no deterioran el acabado, pruebe los productos de limpieza en un area pequefa
y poco visible de las cubiertas metalicas y de plastico.

8.2.0
Exterior

A excepcion de los cables y fusibles externos, el sistema no tiene componentes que el usuario
pueda reemplazar. A continuacion, se enumeran los articulos que se pueden pedir para que
personal de Hologic o representantes autorizados los sustituyan.

e Detector de rayos X digital

e Tarjeta de interfaz PCle

e  Ordenador, monitor, raton y teclado

e Placa de circuito impreso del controlador

e Tubo de rayos Xy fuente de alimentacién de alta tensién

e Fuente de alimentacion de baja tension

8.3.0
Piezas sustituibles

¢ Obijetivo acrilico de dispersioén (0,25 in [6 mm] y 1 in [24 mm] de grosor) 8.4.0

¢ Fantoma ACR (n.° de referencia de Nuclear Associates 18-250) Materiales
e Dosimetro de camara de ionizacién, modelo 451B-DE-SI-RYR de Inovision o similar .

¢ Jarra de plastico con capacidad para 1 galon (4 litros) de agua necesarios
En las siguientes referencias se proporciona mas informacién sobre los procedimientos de 8 5 ()

seguridad del software que se describen en este documento.

Seguridad y ciberseguridad
En caso necesario, se proporcionara cualquier actualizacion de software o firmware distribuida
desde el ultimo mantenimiento en que se haya resuelto un problema de seguridad.

El firmware esta codificado de forma fija en la placa de control, por lo que, en caso de que sea
necesaria una actualizacion del mismo, debera sustituirse la placa de circuito impreso del panel
de control.

Documentos de
referencia e
informacion sobre
la versioén
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Faxitron® Path SECCION.

Sistema de radiografia de muestras mantenimiento

A continuacién, se incluyen las definiciones de los términos tal y como se aplican en este 8 6.0
Programa de mantenimiento. Definiciones

AEC: Automatic Exposure Control (control automatico de la exposicidn): interrupcién de los
rayos X llevada a cabo por el ordenador cuando la sefal suficiente alcanza el sensor.

Ampliacion: movimiento del objeto lejos del sensor y hacia la fuente de rayos X para ampliar
la imagen del objeto en el detector.

Campo plano: correcciones de ganancia y compensacion que se realizan pixel a pixel. La
ganancia y compensacion de cada pixel son diferentes, por lo que debe calibrarse.

Contraste: diferencia porcentual entre la intensidad del objeto y la intensidad del fondo.
Corriente oscura: sefial térmica que se genera en el sensor; (casi) lineal con el tiempo.

Fantoma ACR: fantoma acreditado por American College of Radiology (Colegio de Cardiologia
de los Estados Unidos).

Funcién de transferencia de modulacion, (MTF): medida del contraste y la resolucion de un
sistema de obtencién de imagenes.

Pares de lineas por milimetro: nimero de porciones llenas y vacias alternas. Por ejemplo,
10 Ip/mm significa => {vacia/llena} {vacia/llena}... 10 veces en un milimetro.

Radiografia de un espécimen: obtencion de imagenes de rayos X de una porcion de tejido
extraida del cuerpo.

ROI: regidon de interés. Por norma general, una subregion especifica de una imagen.
Ruido de lectura: medida del ruido RMS en una exposicidon oscura de 0 segundos (sin seial).
SID: distancia de la fuente a la imagen; distancia desde la fuente de rayos X al detector.

UAD: unidades analdgico-digitales.

El mantenimiento peridédico debe realizarse anualmente para garantizar que el sistema 8.7.0

Faxitron Path siga funcionando de forma éptima a lo largo del tiempo. Dicho mantenimiento P

periédico incluye la comprobacion de lo siguiente: Ma':‘ge':"mlento
periédico

e enclavamientos e indicadores de seguridad, seccion 8.8.0;
e prueba de fantoma ACR (verifica el rendimiento de la camara), seccién 8.8.1; y

e estudio radiografico, seccion 8.8.2.

Recomendamos realizar estos procedimientos de forma anual; no obstante, las normativas
gubernamentales podrian requerir programas de mantenimiento mas frecuentes.
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Sistema de radiografia de muestras

Faxitron® Path

SECCION

Programa de
mantenimiento

Enclavamientos, luces, mensajes de error; a realizar anualmente.

Si fuera necesario, imprima esta pagina para utilizarla como referencia.

Anote los resultados en el apartado «Enclavamientos e indicadores de seguridad» del Registro
del mantenimiento periddico de Faxitron Path que se encuentra al final de la seccion.

. El sistema debe estar encendido. El interruptor de cerradura con llave debe estar en la
posicion de las tres y la llave debe estar fijada.

. Compruebe que el LED de encendido esté iluminado. Ningun otro LED deberia estar
iluminado en ese momento.

. Compruebe que la pantalla LCD se ilumine y muestre «System ldle» (Sistema inactivo), y
que no haya ningun otro mensaje, como «Door Open» (Puerta abierta).

. Abra la puerta de los especimenes. La pantalla LCD mostrara el mensaje «Door Open»
(Puerta abierta). Cuando se cierre la puerta, el mensaje deberia desaparecer.

. Encienda el ordenador y el monitor. El software Vision deberia iniciarse automaticamente.
Si no se inicia automéaticamente, haga doble clic en el icono del software Vision para iniciar
el software de obtencién de imagenes. Si, al hacerlo, se inicia una calibracion, permita que
se realice por completo.

. A continuacién, haga clic en el boton Start Procedure (Iniciar procedimiento) y, después,
en el botén Patient Data (Datos del paciente), y seleccione el botéon Enter Manually
(Introducciéon manual) para acceder a la pantalla de entrada del paciente. Cumplimente
todos los campos marcados con un asterisco (*) y haga clic en el botén Accept (Aceptar).
Esto permitira que se lleve a cabo una exposicion.

. Compruebe que el LED «Ready» (Listo) esté encendido. En la pantalla LCD también se
mostrara el mensaje «Ready» (Listo).

. Pulse el botén verde «X-ray» (Rayos X) que esta en la parte frontal del Faxitron Path. El
sistema deberia comenzar una exposicién a los rayos X. Asegurese de que en la pantalla
LCD aparezca una barra indicadora de la exposicién, asi como los kV y el tiempo de la
misma. Compruebe también que el LED «X-Ray On» (Rayos X encendidos) se encienda.
Ademas, durante la exposicion, deberia escucharse un pitido breve una vez por segundo.
Espere a que la exposicion finalice y asegurese de que la imagen aparezca en la pantalla
del ordenador.

. Vuelva a pulsar el botén verde para iniciar otra exposicion. Mientras se esté produciendo
la exposicion, pulse el botén rojo «Stop» (Detener). La exposicion deberia detenerse
después de pulsarlo durante 2 segundos. El timbre dejara de sonar para indicar que la
exposicion se ha detenido. El software mostrara errores de interrupcion, lo que es
perfectamente normal. Al eliminarlos, se podran volver a realizar radiografias.

10.Vuelva a pulsar el botdn verde para iniciar la exposicion. En esta ocasion, abra la puerta

de los especimenes. Esto deberia soltar los interruptores de seguridad y forzar la parada
de la exposicion. Es posible que el software muestre errores, eliminelos.

8.8.0
Enclavamientos e
indicadores de
seguridad
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Faxitron® Path SECCION.

Sistema de radiografia de muestras mantenimiento
Fantoma ACR (solo insertos de cera); a realizar anualmente. 8.8.1

. - . . , Prueba de fantoma
Si fuera necesario, imprima esta pagina para utilizarla como referencia. ACR
Anote los resultados en el apartado «Prueba de fantoma ACR» del Registro del mantenimiento
perioddico de Faxitron Path que se encuentra al final de la seccion.
El usuario debe estar familiarizado con el uso de Faxitron Path y conocer los procedimientos
para tomar radiografias. Complete los procedimientos de configuracion y asegurese de que la
camara esté calibrada (tenga en cuenta los kV y el tiempo de calibracion). Introduzca los datos
del paciente y tome una fotografia de una porcion del inserto de cera del minifantoma ACR
que se muestra en la Figura 8.1 & NOTA: Para realizar la imagen debera retirarse el inserto
de cera de su soporte acrilico.

Figura 8.1

Imagen de rayos X tipica del
inserto de cera del minifantoma
ACR (n.° de referencia de
Nuclear Associates 18-250)

El minifantoma ACR contiene doce
objetos: cuatro masas, cuatro fibras y
cuatro grupos de calcificaciones
(manchas). Por su parte, cada grupo de
calcificaciones contiene seis
calcificaciones o manchas diferentes.
Todas las masas, fibras y calcificaciones
deben ser visibles.

& Nota: El ultimo grupo de
calcificaciones podria no ser visible en
esta imagen.

REQUISITOS DE ACEPTACION

1. Configure el sistema para tomar una imagen manual del inserto de cera del minifantoma
ACR. Ajuste los kV y el tiempo segun lo observado durante la calibracion.

2. Asegurese de que el fantoma esté limpio y sin residuos.

3. Coloque el inserto de cera directamente en la base del compartimento, en el centro del &rea
de imagen. No utilice bloques atenuadores.

4. Encienda los rayos X y espere a que se complete todo el proceso y se muestre la imagen.

5. Al principio de mostrarse la imagen, es posible que no todos los objetos del fantoma sean
visibles. Ajuste los niveles de contraste y de brillo segun sea necesario para obtener la mejor
imagen posible.

6. Una vez corregida la imagen, todos los grupos de objetos deberian ser visibles.

7. Anote los resultados en el Registro del mantenimiento periédico.
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Faxitron® Path SECCION.

Sistema de radiografia de muestras mantenimiento

Estudio radiografico; a realizar, como minimo, anualmente, o en caso de que el
dispositivo se caiga o sufra algun daino.

Puede imprimir las siguientes paginas para utilizarlas como instrucciones para realizar el
estudio radiografico.

Anote los resultados en el apartado «Estudio radiografico» del Registro del mantenimiento
periddico de Faxitron Path que se encuentra al final de esta seccion.

Para garantizar que las emisiones de radiacion estén dentro de los limites necesarios, el
fabricante recomienda que se realice al menos un estudio radiografico al afio*. Si la maquina
sufre alguna clase de dafio tras su instalacion, debera realizarse un estudio radiografico antes
de volver a ponerla en funcionamiento en las instalaciones.

Herramientas necesarias

e Dosimetro radiografico con fuente de comprobaciéon (se recomienda un dosimetro de
camara de ionizacion como el modelo 451B de Inovision; el dispositivo incluye la fuente de
comprobacion).

e Jarra de plastico con capacidad para 1 galén (4 litros) de agua.

Comprobacién del funcionamiento del dosimetro
1. Fecha de calibracién: compruebe que la calibracion del dosimetro esté actualizada.

2. Revision de las pilas: compruebe el estado de las pilas. Si fuera necesario, reemplacelas.

3. Revisidon del funcionamiento: (y de la fuente de comprobacién, si esta disponible).

& Nota: Los siguientes pasos solo se aplican al modelo 451B de Inovision o a dosimetros
de camara de ionizacion similares. Para otros medidores, siga las instrucciones del
fabricante.

e Abra el protector beta deslizante situado en la parte inferior del dosimetro.

e Coloque el medidor sobre la fuente de comprobacién y monitorice durante
30 segundos.

e La lectura del dosimetro deberia encontrarse dentro de la tolerancia indicada en la
etiqueta de calibracion.

e Anote la lectura en el Registro del mantenimiento periddico.

o Cierre el protector beta del medidor.

Notas importantes:
1. Todas las medidas de radiacion se realizan con el dosimetro radiografico a no mas de 2 in
(5 cm) de distancia de la superficie de la unidad Faxitron Path.

2. Al anotar las medidas de radiacion, es posible que deba multiplicarlas por 0,1 para convertir
la lectura de pSv/h a mR/h. Por ejemplo, 12 pSv/h equivalen a 1,2 mR/h.

8.8.2
Estudio
radiografico
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Faxitron® Path

Sistema de radiografia de muestras

SECCION

Programa de
mantenimiento

Procedimiento de estudio radiografico

1. Haga una lectura de la radiacion de fondo (con el medidor hacia el centro de la habitacién)
y anote el resultado.

2. Configure el sistema para tomar una imagen manual.

a.

C.

Haga clic en el boton Device Panel (Panel del dispositivo) y seleccione Full Manual
(Totalmente manual).

Arrastre los controles deslizantes de los kV y el tiempo tan a la derecha como es
posible para ajustarlos al maximo.

Haga clic en el boton «SET» (AJUSTAR).

3. Compruebe que el LED «Ready» (Listo) esté encendido.

4. Abra la puerta del compartimento. Coloque la jarra de plastico con 1 galén (4 litros) de agua
en el area de imagen de la base del compartimento y cierre la puerta.

5.Pulse el botdon «START» (INICIAR) y mida las emisiones de radiacion en la parte superior,
frontal, posterior y en ambos laterales del armario. Analice lentamente toda la superficie con
el medidor. Cada andlisis deberia tardar 1 o 2 exposiciones a los rayos X. & Nota: Para
completar el estudio completo, tendra que iniciar los rayos X en varias ocasiones.

6. Anote las lecturas de cada lugar de la prueba.

7.Si cualquiera de las lecturas es superior al limite de radiacion de Hologic de 0,1 mili-
Roentgens (mR) por hora (1,0 ySv/h) en cualquier punto a 5 centimetros (cm) de distancia
de la superficie exterior (*), pongase en contacto con un representante de Hologic para
discutir las opciones de reparacion.

(*) El limite maximo fijado por el CDRH de la FDA de EE. UU. para los armarios de
rayos X es de 0,5 mR/h a 5 cm (2 in) de las superficies externas. Si se utiliza en otro
pais, consulte los limites oficiales vigentes para los equipos de radiografia para el
diagndstico in vitro tipo armario.

En algunos paises, los puntos para la prueba deben situarse a 10 cm de las superficies
externas. En este caso, a 10 cm de las superficies externas, la lectura de la emision de
radiacion de los sistemas deberia ser inferior a 0,1 mR/h.

8. Retire la jarra de agua del compartimento de rayos X.

9. Si el sistema esta sobre una mesa o si hay personal en el piso inferior a donde este se usa,
debera realizarse un estudio de la parte inferior de la cabina de rayos X. Compruebe que no
haya nada en el compartimento de rayos X, inicie los rayos X y analice la parte inferior del
compartimento. Anote la lectura.

8.8.2 Cont.
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Faxitron® Path SECCION.

Sistema de radiografia de muestras mantenimiento

Registro del mantenimiento periodico de Faxitron Path

N.2 de serie del sistema: N.2 de serie de la camara:

Enclavamientos e indicadores de seguridad (seccion 8.8.0)

Satisfactorio: Insatisfactorio: Iniciales: Fecha:

En caso de resultado insatisfactorio, indique las razones y las medidas emprendidas para corregir el fallo.

Iniciales: Fecha:

Prueba de fantoma ACR (seccion 8.8.1)
Numero de objetos observados: Masas: Fibras: Grupos de calcificacién:

Satisfactorio: Insatisfactorio: Iniciales: Fecha:

En caso de resultado insatisfactorio, indique las razones y las medidas emprendidas para corregir el fallo.

Iniciales: Fecha:

Estudio radiografico (seccion 8.8.2)

Lectura de la radiacion en: |:| mR/h |:| uSv/h Fuente de comprobaciéon: __ De fondo: ____

Parte frontal: Lado derecho: Parte superior:
Parte posterior: Lado izquierdo: Parte inferior:
Satisfactorio: Insatisfactorio: Iniciales: Fecha:

En caso de resultado insatisfactorio, indique las razones y las medidas emprendidas para corregir el fallo.

Iniciales: Fecha:

El mantenimiento periddico identificado anteriormente fue completado por:

Fecha de realizacion: Firma:
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